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That's Write User Manual 

All representations or warranties with respect to the 

software program herein are made by COMPO Software 

Ltd and contained in the End User License Agreement 

supplied in the That's Write package. 

Further, COMPO Software reserve the right to revise this 

publication and to make changes from time to time in the 

contents hereof without the obligation of COMPO 

Software to notify any person of such revision or change. 

Distribution disks may include a README file. The 

contents of this file and any references within it to other 

files explain variations from the manual which do 

constitute modification of the manual and the items 

included therewith. Make sure you read this file before 

using the software. 

Copyright 1991 COMPO Software Ltd. All rights reserved. 

No part of this publication and program may be 

reproduced, transmitted, transcribed, stored in a retrieval 

system, or translated into any language or computer 

language, in any form or by any means, electronic or 

mechanical, magnetic, optical, chemical, manual or 

otherwise without prior written consent from COMPO 

Software Ltd, 7 Vinegar Hill, Alconbury Weston, 

Huntingdon, Cambridgeshire, PE17 5JA. 
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Atari ST and TT are registered trademarks of Atari Corp. 
Epson is a trademark of Epson America, Inc. 
Gem is a trademark of Digital Research Inc. 
1st Word and 1st Word Plus are trademarks of GST 
Software Products Ltd. 
That's Write and Write ON are trademarks of COMPO 
Software Ltd. 

This manual was produced using That's Write Version 

1.51 on an ATARI ST(E) with 4 Megabytes of memory and 

an Atari SM124 Monitor. Camera ready artwork was 

produced on an HP Deskj et 500 printer. The fonts used 

are those supplied with That's Write. 
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1 . Introduction 

That's Write is one of the most powerful word processing 

programs available for the Atari ST. Although it is easy 

to use and easy to learn, we strongly advise you to read 

this manual very carefully. It should contain the answers 

to all of the questions that could arise during the 

copying, installation and use of That's Write. 

Please ensure that you complete the Registration Card 

included in the That's Write pack and return it to us as 

soon as possible. Unless we are in possession of your 

Registration Card we do not normally provide technical 

help if you encounter any problems with That's Write. 

Even more importantly, That's Write is under a process of 

continued development - unless we know that you have 

purchased That's Write we can't tell you about updates 

and enhancements to the program unless we know who 

you are. We only know who you are if you fill in the 

registration card and send it to us. 
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1.1 Conventions used within this manual 

Keys to be pressed are enclosed in [], for example 

[Return]. 

If either of the three keys [Shift], [Alternate] or [Control] 

are used it is assumed that these are held down whilst 

any other keys following are pressed. For instance, 

[Control][F][S] means hold down the Control key, press 

and release the F key, press and release the S key, then 

release the Control key. The keys with arrows on them, 

located between the main keyboard and the numeric 

keypad, are referred to as cursor keys. 

Any command, menu item or button that you should see 

on screen is in single quotes eg 'Cancel' or 'Open 

Text...'. 
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1.2 The README file 

Before you install the program please look for, and study, 

the 'README' file on Master Disk 1. All updates which 

could lead to differences between the current program 

version and this manual will be listed in the 'README' 

file . 
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1.3 Technical support 

For technical support on That's Write please consult your 

dealer or telephone the Helpline. 

You will find details of the telephone number and 

opening hours of the Helpline in your That's Write 

package. 

If you have a problem please make sure that you have 

checked the manual and the contents of the 'READ ME' 

file on Master Disk 1 before phoning the Helpline. Before 

calling please try and have the phone next to your 

computer and the computer switched on. Also have ready 

your registration number and the version number of your 

software. 
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1 . 4 Getting started 

The That's Write Help program (THELP.PRG), supplied 

with That's Write will help you to make backups of your 

That's Write Master Disks and then configure and install 

the That's Write program. These functions are set out in 

Chapters 2 and 3 of this manual. 

You will require the following additional disks for the 

backup and installation procedures. 

Backup: 

Installation: 

Three unformatted double sided 

disks. 

Unless you are installing to a hard 

disk you will need one blank 

formatted disk. (The 'Installation' 

function does not format this 

disk). 

Newcomers to word processing on the Atari ST should 

read the remainder of this chapter before proceeding with 

the backup and installation functions. Users who are used 

to working with word processing programs on the ST can, 

if they wish, move on to Chapter 2. 
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1.5 Beginner's guide to word processing 

Using a word processor is very similar to using a 

typewriter but much more flexible. Unlike a typewriter 

you can change existing text quickly and easily and then 

print out a new copy. To make this quick change of text 

possible, That's Write must know where you wish to 

place the text. Any text that is typed on the keyboard is 

placed immediately before the cursor, which is displayed 

on your screen as a vertical blinking bold line. The 

cursor can be moved around within the text either by 

using the cursor keys or with the mouse by positioning 

the. mouse pointer where you want the cursor and clicking 

on the left mouse button. 

One important difference between a word processor and a 

typewriter is that you should not press [Return] at the end 

of each line. A word processor automatically selects the 

best place for a line break. [Return] is used to mark the 

end of a paragraph and moves the cursor to the beginning 

of a new line. 
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If you move the cursor within your text you can insert a 

character, word or piece of text at the current cursor 

position. The text after the cursor position is 

automatically moved to the right to make room for the 

inserted text. 

You can also delete a character. [Delete] will delete a 

character to the right of the cursor and [Backspace] will 

delete a character to the left. That's Write has many 

other attributes that far surpass the functions of a 

typewriter. Enjoy exploring these as you progress through 

the manual. 

Like most good programs for the Atari ST, That's Write 

uses the GEM working environment which is part of the 

Atari ST's operating system. All programs which use 

GEM can be used in a similar way. The most important 

commands are listed in the drop down menus available 

from the menu bar at the top of the screen. Moving the 

mouse arrow to any heading on the menu bar will drop 

down the commands in that menu. Additional information 

or options from some commands arc displayed in Dialogue 

Boxes which contain Text Fields and Buttons. Alert 

Boxes, a form of dialogue box are intended to inform you 

of a potential problem or warn that data will be 

irrecoverably lost if you proceed. 
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* At all times you should be able to click on [Cancel] 

to stop anything untoward happening to your That's 

Write document. The key to using That's Write 

successfully is to follow the backup and installation 

process carefully and then 'have a go'. Don't try and 

use That's Write for the first time with a particularly 

important document. Rather, start by playing with it 

and exploring its power. Then proceed with the skills 

that you have learnt to impress. 

As this manual is not intended to be an Atari ST tutorial 

manual, we must from this point on assume that you have 

read and understood the user manual that came with your 

ST. That knowledge is essential for working with any 

computer program. 

One of the more important chapters in this manual is the 

one about formatting text. Understanding the powerful 

formatting capabilities of That's Write can bring 

consistency to all your documents and save you a lot of 

time when working with long documents. The final 

chapters cover auxiliary programs which are included in 

the That's Write package; That's Snap, Key Show, That's 

Select and That's Font. 
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2. Backup copy of Master Disks 

The Master Disks supplied with That's Write are write 

protected (the black notch on the reverse side of the disks 

is pushed up). As long as you don't change the position of 

the black notch you are secure in the knowledge that no 

matter what might go wrong when you are installing 

That's Write, your That's Write Master Disks will never 

be effected. 

Please ensure that before attempting anything set out in 

this manual you first make a backup copy of each of the 

three Master Disks as described later in this chapter. 

Then place the original Master Disks in a safe and secure 

storage place. 

It is good disk management to make a backup copy of 

Master Disks. The That's Write Master Disks are not in 

any way copy protected, but may contain 10 sector 80 

track format instead of the more usual 9 sectors per track. 

The That's Help program, THELP.PRG, includes a copy 

function which automatically detects 10 sector 80 track 

formatting procedure. You will require three unformatted 

disks to make your backup copies. 
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* You can use disks that have already been formatted 

but any existing files on them will be deleted beyond 

all hope of recovery. 

The following instructions assume that you have one or 

two double sided disk drives. 

Do not attempt to use a single sided disk drive during 

backup - if you do then the backup process will not work! 

Place Master Disk 1 in the internal A disk drive, and 

double click on the 'A' disk icon to display a list of the 

file"s on disk. 

Double click on 'THELP.PRG' and the following screen 

will be displayed: 
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Move the mouse arrow onto 'File' in the menu bar at the 

top of the screen and you will get a drop down menu like 

this: 

Click on 'Copy disk. .. ' and the following dialogue box 

will appear: 

13 



User Manual That's Write 

Click on A as your Master Disk is in drive A. The 

following dialogue box will appear: 

Click on A (or on B if you have a second double sided 

disk drive and the destination disk will be in drive B). 

The following dialogue box will appear: 
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Click on 'OK' and after a while the following dialogue 

box will appear: 

Insert one of the unformatted double sided disks and click 

on 'OK'. This procedure includes disk formatting so it 
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will take a while to complete. The following dialogue box 

advises you that the copy function is complete: 

Repeat the copy function for That's Write Master Disk 2 

and Master Disk 3. Mark the backup disks as 'That's 

Write Master Disk 1 backup (M 1)', 'That's Write Master 

Disk 2 backup (M2)' and That's Write Master Disk 3 

backup (M3). 

You should store your original That's Write Master Disks 

somewhere safe and from now on use only your newly 

backed up disks. You will only need to use your original 

disks again in an emergency or to obtain updates to your 

software. 

16 



That's Write User Manual 

* Write protect all three of your backup disks by 

pushing the tab on the underside of each disk up so 

that a small square hole is visible in the top corner 

of the disks. Now you are doubly safe! If anything 

should go wrong you have got copies of your disks 

stored safely away. If all else fails you can revert to 

taking new backups of your Master Disks and start 

again. If there is a rule in using computer software it 

is to make good backups of anything important - then 

experiment, nothing can be lost and a lot can be 

learnt! 
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3. Installing That's Write 

Now that you have created backup copies of your original 

That's Write disks it is necessary to create a working 

copy of That's Write configured for your particular 

hardware. 
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3.1 Selection of printer driver 

After you have made your backup copies of the Master 

Disks, 'Quit' from the That's Write Help program and use 

the ST's Desktop to display the contents of the Backup 

Disks (Ml, M2 and M3). 

The files with a .ARC extension contain a number of 

files in a special packed format. During installation 

That's Write Help will unpack these automatically and 

once installation is complete you will see that some new 

files have been created. The LASER.ARC file is, as its 

title denotes, for use with laser printers. The N24.ARC 

and N9.ARC files refer to 24 pin or 9 pin printers. 

Irrespective of the particular type of printer that you 

have, there is no need to remove any of these .ARC files. 

During the installation procedure, That's Write Help will 

only install those files that are required to support the 

particular printer type and model that you specify. 

* It is not possible to install That's Write using a 

single sided disk drive. However, if you contact the 

Helpline they should be able to create a single sided 

version with slightly limited functionality for you. 
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* If you have not read the RHADME file on these disks 

it is time to do so now. When the file named 

RHADME is displayed on screen double click on it. 

At the dialogue box, click on 'Show' and read the 

file's contents carefully. 
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3.2 Installation of That's Write Work Disk 

For the purpose of this installation section we shall 

assume that you have two double sided disk drives. 

The 'Installation· function uses only one floppy drive, 

consequently there arc a number of disk changes. If you 

have a hard disk you will get different screen prompts. 

However, the general procedure is the same. 

You will require one formatted blank disk. The 

'Installation' function does not format this disk. You 

should commence installation with Backup Disk (M 1) in 

the internal A drive. Label your blank formatted disk 

That's Write Work Disk. 

* The installation function reads files from the Master 

Disk in a compressed format and then writes them out 

in an uncompressed format. Thus writing files takes a 

lot longer than reading them so be patient during 

installation and only call the Helpline if nothing 

happens after more than 10 minutes of the 

installation program apparently writing to your disk. 
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* If you have a hard disk That's Write can be installed 

to any partition on it. You will not need a formatted 

disk, 'Installation • will copy all necessary files to 

your hard disk. 
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3. 3 Procedure 

Place disk Ml in drive A. First double click on the 'A' 

drive icon then on the 'THELP.PRG' icon. Move the 

mouse pointer to 'File' in the information line and the 

'File' menu will drop down: 

Click on 'Installation ... ' and the following dialogue box 

will be displayed: 
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Drive: I single sided I I double~ I Hard disk I 

Path: C:\-------------------------------------

Atarl Laser SLH 884 

Star LC-24 Draft+180x360 (standard, graphit tharset) 
Star NB-24 (Standard Mode) 
Star NL-10 Epson Interfate 
Star NL-10 IBM Interfate 

Using the mouse arrow, select and click on the 

appropriate drive type for your system. The selected box 

will be highlighted. 

* For hard disk systems you may add a path name to the 

folder into which you want That's Write to be 

installed. 

Click on either of the two arrow characters to scroll all 

the printer drivers listed and then click on the one most 

suited to your printer. The selected printer will be 

highlighted. 

Click on 'OK' and some of the files on disk Ml will be 

read into memory. 
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The following dialogue box is then displayed: 

Follow the instructions given by the installation program. 

When installation is complete you will see the following 

screen message: 
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Click on 'OK' to return to the That's Write Help screen 

and select 'Quit' from the 'File' menu. 
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3.4 Final transfer of files 

Using the Desktop you will find that your Work Disk 

contain the files given in the 'README' file. 

Now copy the following folder and files from Backup Disk 

M2 to Work Disk 1 using the Atari Desktop: 

KEYSHOW.ACC 

TSNAP.ACC 

FSEL.ACC 

DEMOl.TW 

DEM02.TW 

You may prefer to copy all demo files, those marked with 

the TW identifier, to a separate document disk or if you 

have a hard disk, to, a separate document folder. If you 

are going to do a lot of work with That's Write, it is good 

practice to have a separate disk for these files. It is very 

easy to recall them when using That's Write. 
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On Backup Disk M2 you will also find a folder named 

Auto, double click on this folder to display its contents. 

You should now see a file called AUTOINF. Display it on 

screen by double clicking on the file and selecting 

'Show'. Follow any appropriate instructions in this file. 

28 
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3.5 Installing additional printer drivers 

An additional printer driver can be installed in a similar 

way to installing the main That's Write program. To 

install a new printer you don't need to select the type of 

drive again, only the desired printer. 

* Before installing an additional printer driver, rename 

the printer driver file for your existing printer -

TWRITE.TWP - to the name of your printer, eg 

STARNLIO.TWP. 

* There is not enough space for more than one printer 

driver on a floppy disk based system. If you want to 

use more than one printer driver from floppy disk, you 

must completely re-install That's Write onto new 

disks for the second printer. 

Place disk M 1 into the internal A drive and double click 

on 'THELP.PRG'. 

When the That's Write Help screen appears, move the 

cursor to the 'File' menu and click on 'Installation'. 
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The 'program/printer installation' dialogue box will now 

be displayed. DO NOT select a 'Drive' option. Click on 

either of the two arrow characters to scroll all the printer 

drivers listed and then click on the most suitable printer. 

The selected printer will be highlighted. When you are 

satisfied with your selection, click on 'OK'. You may of 

course quit from the installation program at any stage by 

clicking on 'CANCEL'. If you click on 'OK' the 

following reminder dialogue box will appear: 
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locate TWRITE.IHF 

A:\*, IMF------------------------------

Drive: 

mm m 
mm 

ID I!I!I!Im~~!lll . 

I~ TWRITE ~ 
2 TWRI~E , IMF 

f 11 e : ~------- . - - -
1 OK I I Cancel I 

User Manual 

When printer installation starts, the program will prompt 

you for the location of the 'WRITE_ON.INF' file. 

Exchange disks as requested, following the instructions 

given by the installation program. Once the additional 

printer driver has been installed this will be confirmed 

by a dialogue box. Click on 'OK' to return to the That's 

Write Help screen and select 'Quit' from the 'File' menu. 

You can now change your printer driver via the 'Printer 

Type .. .' command in the 'File' menu. The active printer 

is identified in the dialogue box which is displayed when 

you issue the 'Print...' command. 
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The last printer installed will automatically be the 

default printer (TWRITE.TWP). If you want to change the 

default printer, change the name of TWRITE.TWP to the 

name of your appropriate printer - eg HPDJ.TWP. Then 

rename another .TWP file to TWRITE.TWP. 
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4. Using That's Write 

4.1 Quick introduction 

If you have just purchased That's Write and have not 

used a word processor before follow these instructions to 

get That's Write started otherwise skip to section 4.2. 

a) Insert That's Write Work Disk 1 into Drive A and 

start the That's Write program by double clicking on 

'TWRITE.PRG'. 

b) At this stage, ignore everything on the screen except 

the text window (the large white area where you can 

see a blinking vertical cursor line). Type the 

following text just as you would when using a 

typewriter. 

"Due to the very well thought out design of That's Write, 

it is very easy to use; it's a word processor for everyone 

who wishes to write or process text. Even as a beginner 

you can use That's Write without any problems. That's 

Write will turn your Atari ST into a professional word 

processor, enabling you to produce superb quality output 

quickly and easyly." 
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c) Stop. Now if you have been true to the above 

instructions you should have made a mistake in the 

last word of the final sentence, spelling 'easily' as 

'easyly'. Click on the 'y', which obviously should 

not be in the word, and the cursor will appear 

between the 's' and the 'y'. Press the [Delete] key 

and then type [I] to correct the error. 

d) Read through the text to see if there are any more 

mistakes. If you find any correct them. Now that you 

have finished processing your text let's save it to 

disk. Move the mouse arrow to 'File' on the menu bar 

and then move the arrow down to the 'Save as .. .' 

command and click on it with the left mouse button. 

A dialogue box will be displayed in which you can 

type a file name for your document. At the cursor 

position, type in a name up to eight letters long, 

press [.] and type TW. TW is the That's Write 

identifier for a document file. Press [Return] or click 

on 'OK' and your text will be saved to disk. 

e) If you have two disk drives the file should be saved to 

drive B. If you have a hard drive, you could have 

saved it to a partition of your hard disk by selecting 

the appropriate drive button in the dialogue box 

before pressing [Return] or clicking on 'OK'. 
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0 Now prepare your printer. Select 'Print ... ' from the 

'File' menu and click on 'OK' in the print dialogue 

box. Do not worry about the other printing options 

available at the moment, these will be explained as 

you progress through the manual. Your text should 

now print out on your printer. 

That's all you have to do to write and print text using 

That's Write. Assuming you have a normal speed printer, 

the above process should only have taken about five 

minutes to complete. 
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4. 2 That's Write and other WP software 

When a document is saved from a word processing 

program the text is saved as well as various attributes 

given to it such as the font and style of your text, the 

page size and layout, tab settings etc. 

Since word processing programs have varying features the 

way they store this information is nearly always different. 

It is normally impossible to transfer text from one word 

processor to another and maintain exactly the same 

styles, page layout etc. 

That's Write can read text in five different formats. In its 

own That's Write format all the document's original 

attributes are retained since you last saved it. Similarly, 

you can load Write ON files and retain all attributes. 

With documents created using either 1st Word or 1st 

Word Plus the text is read in and text attributes eg bold, 

underline etc are maintained. Finally, text can be loaded 

using the popular ASCII file format. 
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Most word processing programs and many programs that 

use text based information can save files in ASCII 

format, these files can then be imported into That's 

Write. When importing an ASCII file into That's Write 

the text will be in normal style. Any other style 

previously given to it, eg bold, will be lost. 

Further information on loading text into That's Write is 

contained in Section 6.1.2. 
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4. 3 Control commands 

Working with the mouse is very easy and makes using 

programs quite simple. However, use of the mouse can be 

a hindrance to speed for the experienced user. For 

example, having to take your hand away from the 

keyboard to manipulate the mouse makes touch typing 

impossible. That's Write offers the option of doing 

everything using keyboard commands. 

* Keyboard commands will only be recognised if you 

press and hold down [Control] whilst successively 

pressing the command character(s). If That's Write 

does not recognise the second character of a 

sequence as a valid command it will proceed as if no 

command had been issued. For example, the 'Save' 

command can be issued by the key combination 

[Control][F][S]. Just press [Control] and hold it down 

whilst pressing first [F] and then [S]. 

* The commands for the menu functions are made up as 

[Control], the first letter of the drop down menu plus 

the first letter of the command. Therefore the 

command 'Bold' would be [Control)[S][B], S stands 

for the 'Style' menu and B for 'Bold'. 
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* The buttons in the dialogue boxes can also be 

selected by using the first letter rule. For instance 

the 'Italic' button in the 'Paragraph Layout .. .' 

dialogue box can be selected by typing [Control][I]. 

Because some commands begin with the same letter it 

has not been possible to apply the first letter rule to 

every case. Where possible each command letter is shown 

on screen. For others the command letter has been made 

as mnemonic as possible and detailed in this manual. 
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4.4 The That's Write file selector 

When calling a disk related function, an extended file 

selector will appear which shows the function to be 

executed in the top line. The next line shows the current 

path. You can move the cursor to this line to change the 

path with either the cursor keys (arrow up or down) or the 

mouse. 

There is a button for each available disk drive (or hard 

disk partition). When you click on one of these buttons 

the path will be changed to the requested drive and the 

corresponding directory will be displayed. 

In the bottom part of the file selector box there are 

buttons for the quick selection of various file name 

extensions . The number and contents of these buttons 

depend on the function to be performed. All functions are 

available via the mouse or the keyboard. To switch to a 

different drive either click on the appropriate drive letter 

or press [Control] and the required letter. To choose a file 

either click with the mouse or press [Control] plus the 

appropriate file number. As with all That's Write 

dialogue boxes 'OK' can be selected by pressing [Return] 

and 'CANCEL' by pressing [Undo]. 
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When you insert another disk into the selected disk drive, 

click on the grey field above the directory listing or press 

[Control][Help] to read in the directory of the new disk. 

For instance if you click on 'New' in the 'File' menu or 

type [Control][F][N], you will get the following dialogue: 

~~~ llll'lll Tupe Block Stule Lauout Ed11 Options 
neH.,tH !h Pld .I n~ H.! I· 1 1 :alllfl l Hiti .l <:> <> in <H~.O. i 
~ 2 ~ ~.~ ~! • 

Open teKt 

E: \ TWRITE\* , TW- -------------------

Drive 

mm m 
mm 

~ ~J ~~~~~ , TW 
3 DEH021t , TW 

[!;][] 1*. Tn I File: ~------·--
I*.DOC I [!;!:] I OK I I Cancel I 

[Control][A][B ], .. . 

[Control][1][2], .. . 

[Control][(] 

[Control][)] 

[Control][/] 

[Control][*] 

[Control][Help] 

[Control][Backspace] 

Drive A,B,C etc 

File 1,2 etc 

Extension *.WO 

Extension *.DOC 

Extension *.TXT 

Extension*.* 

Re-read file directory 

Close Folder 
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* Note that [(],[)],U],[*] refer to the keys above the 

numeric keypad on the right hand side of the 

keyboard. 
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4. 5 Text windows 

That's Write lets you work on two different text files at 

the same time. 

To do this click on the grey area of the Info line (the line 

directly below the menu bar line), where the name of the 

current file and other information is displayed, and pull it 

down. A second Info line and text window will become 

visible. Select the window you wish to work in by moving 

the mouse arrow into the text area and then click on it. 

The window containing the cursor indicates which text 

window is currently active. 

The active window's information line is in a slightly 

darker shade to that of the inactive window. 

This is the active window ... see how the lnfo 1 ine is slightly 
darker than the one above. Also notice that the cursor is in this 
window .lit 

The picture shows two text windows in use. The active 

window is shown with the cursor. 
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You can also change windows with [Control][D][W]. 

[Control][D][l] and [Control][D][2] select either the first 

and second window respectively. 

All commands work identically in both text widows. Text 

can be moved from one window to another with the 'Cut' 

and 'Paste' commands from the 'Block' menu. 
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4.6 The menu bar 

In Chapter 6 all entries in the menu bar are described in 

the order in which they appear. Each section starts with 

the name of the command being described as it appears in 

the menu. It is followed by the keyboard equivalent in 

the That's Write command set. A full description of the 

command then follows. 

* If a command in a menu is followed by three dots 

( ... ), a dialogue box will appear after the command 

has been selected in which you can enter additional 

information to fine-tune the command. This dialogue 

box will always include a 'Cancel' button enabling 

you to return to your text without making any 

changes ... so, explore in safety! 
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5. Formatting text 

One of the main advantages word processors have 

compared with typewriters is the ability to quickly 

reformat text. Before you start to write a long document it 

is strongly recommended that you carefully study the 

formatting options that That's Write offers. 

To get the best from That's Write you should use page 

and paragraph layouts as the primary means of formatting 

text. Each page is formatted according to that page's 

'Page Layout...' and each paragraph is formatted 

according to the 'Paragraph Layout. .. ' assigned to it. 
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5.1 'Page Layout ... ' 

'Page Layout ... ' is used to specify the size of paper and 

the areas available for text. The paper size is mainly 

determined by the physical size of the sheets of paper you 

use, but you must also take into account the fact that 

most printers cannot start printing at the very top or 

bottom of the paper when using single sheets of paper. 

The left and right margins are valid for the main text as 

well as for headers and footers. Nothing is ever printed 

outside these margins. 

The TOF (top of form) margin is the distance from the top 

of the page to the beginning of the header. The difference 

between the TOF margin and the top margin is the space 

available for the header text. The following diagram 

illustrates this. 
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The foot margin is the distance from the beginning of the 

footer to the bottom of the page. This is the area 

available for the footer text. Taking the difference 

between the foot margin and the bottom margin gives the 

distance between the main text and footer text. 

The right margins (specified in the 'Paragraph Layout .. .') 

of both the main text and headers/ footers must not extend 

beyond the right margin given in the 'Page Layout ... '. 

Similarly, headers and footers must not contain more 

lines of text than can fit into the available space. If these 

rules are not conformed to, text that has been placed 

outside the allowed area may be cut off during printing. 
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There are some other aspects of formatting that concern 

more than a single paragraph and are thus part of the 

'Page Layout ... '. 

When page breaks are calculated by That's Write, 

sometimes a single line of a paragraph is left alone at the 

top or bottom of a page. That's Write allows you to 

specify the minimum number of lines of a paragraph that 

should be kept together on the same page. This option is 

available within the 'Page Layout ... ' command from the 

'Layout' menu. If you set the 'Number of lines at start of 

paragraph' to three no page break will occur within the 

first three lines of a paragraph. If these three lines do not 

completely fit onto a page, the whole paragraph will be 

moved to the next page. The minimum number of lines at 

the end of a paragraph is handled in the same way. 

Other 'Page Layout' functions such as multi-columns and 

footnote spacing are described in section 6.5.2. 

* Do not get confused between footers and footnotes. 

Footcrs arc printed on every page of text with a 

particular page layout. Footnotes are references 

shown in a document as a number with further text 

printed automatically at the bottom of a page. That•s 

Write automatically sets the space for the main text 
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on a page so that there is enough space to print the 

footnote references on the page. 

* You can have a number of page layouts in the same 

document. Why? well, flick through this manual and 

you will see how the chapter headings on a page 

change when the chapter changes. This is achieved 

by having different page layouts for each chapter -

each with a different header. 
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5.2 Pagination 

The calculation of page break positions within a 

document is called pagination . You can leave this task 

entirely to That's Write which uses the rules explained 

in the preceding section. 

During pagination and printing, empty lines at the top of 

a page are ignored. This results in neater looking 

documents. If you need to retain blank lines, eg for a 

picture or a diagram to be pasted in after printing, you 

should put a space character on each otherwise blank 

line. 

Page breaks that are calculated by That's Write are 

called soft page breaks and may change if you add further 

text, change text style, or change the 'Page Layout .. .'. 

Soft page breaks are marked in the far left hand column, 

called the page break column, by a dashed line. 
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If you want to keep a number of lines together, for instance an 
important paragraph, then position the mouse pointer in the page 
break column next to the first line of the paragraph, hold down 
the left mouse button and drag the mouse pointer to the last 
l ine of the paragraph. Release the mouse pointer and you wil l 
see a tinted block indi cating that all lines within the block 
will be kep t on the same page. 

You can force a page break in your document. A forced 

page break is called a hard page break. To set and remove 

a hard page break click on the left mouse button at the 

appropriate place in the page break column or press 

[Control][D][P]. 
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5.3 Paragraph layout 

A paragraph layout specifies the format of a par~graph. 

Each class of paragraph, eg normal text and various 

headings can have its own unique layout. There are 

considerable advantages in using paragraph layouts 

compared to the traditional way of formatting text that is 

used by most word processors. Using paragraph layouts 

leads to fewer layout mistakes and enables you to very 

simply change the format of your document after the text 

has been entered. For example, if you decide that your 

headings should be printed in italics instead of being 

underlined, you only need to modify the particular 

'Paragraph Layout ... ' that is associated with those 

headings. That's Write will automatically change all 

headings to the new format. 

Each 'Paragraph Layout ... ' contains information about 

the default font and style to be used as well as 

information about line spacing, margins, tab positions 

and justification. You can of course still select another 

font or style for parts of any paragraph. 
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This paragraph is "justified", which means that all lines 

extend to the right margin except the last one. This 

paragraph is "justified", which means that all lines 

extend to the right margin except the last one. 

This one is "left aligned", the text is ragged on the right 

margin. This one is "left aligned" so that the text is 

ragged on the right margin. 

This paragraph is "right aligned" so that the text is 

ragged on the left margin. This paragraph is "right 

aligned" so that the text is ragged on the left margin. 

and this one is "centred". 

Experiment with paragraph layouts and examine how they 

are used in the example documents, it will help you 

greatly in using That's Write to its full potential. 

There are two left margins for each paragraph, one for the 

first line and one for the remaining lines. This makes it 

possible to have automatic paragraph indents or outdents. 

Both left margins specified in the 'Paragraph Layout...' 

are measured from the left margin specified in the 'Page 

Layout...'. The left margin specified in the 'Page 

Layout ... ' therefore becomes in effect a left margin 
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datum. If the paragraph margins are set to zero they are 

the same as the page left margin. 

The right margin is specified by its distance from the left 

margin as set in the 'Page Layout...' so that it gives the 

length of a line if the left tab is set to zero. 

Up to 100 tab positions are available for each 'Paragraph 

Layout...'. That's Write offers four different types of tabs: 

left aligned, right aligned, centred and decimal. Their 

significance is demonstrated by showing what £120.34 

and £0.5 look like when placed at one of each tab types. 

£120.34 
£0.5 

£120.34 
£0.5 

£120.34 £120.34 
£0.5 £0.5 

Margins and tabs are displayed in the ruler line. (See 

section 5.4) 

* Understanding the last three sections 5.1-5.3 is 

fundamental to getting the best out of That 9 S Write. 

Browse through these sections again to grasp fully 

how the formatting of text is controlled and which 
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5.4 The ruler line 

In the ruler line you can adjust the tab positions and the 

left indent and right margins of the 'Paragraph Layout...' 

that is assigned to the paragraph in which the cursor is 

currently placed. 

The ruler line has marks at distances of 1/ 10 inch, ie the 

width of a standard character on a typewriter and numbers 

give the distance from the left hand edge in centimetres. 

That's Write approximates 2.5 centimetres to one inch 

which is usually adequate for this purpose. The inch 

measurements are exact. 

Margins and tabs can only be set on a particular mark ie 

not between marks. 

To adjust the left and right margins position the mouse 

pointer on the appropriate symbol, keep the left mouse 

button pressed down and slide the symbol to a new 

position. 
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The symbol for the left margin is a triangle that points to 

the right . 

0 I 
I 

The symbol for the first line left margin looks almost the 

same, but instead of being solid black it consists of two 

vertical lines. 

These symbols can be picked up and dragged using the 

mouse. 

The symbol for the right margin is a triangle that points 

to the left. Again, this can be adjusted for a particular 

paragraph using the mouse . 

.1.4 .1.5 

Tabs can be set and removed by clicking on the required 

position. Set them with a single click and remove them 

with a double click. 
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Clicking once with the left mouse button sets a left 

aligned tab . 

-6--
~ 

Clicking once with the right mouse button sets a right 

aligned tab. 

-6--
~ 

Clicking once with the left button on an existing left 

aligned tab changes it to a centred tab. 

6 
,y, 

Clicking once with the right button on an existing right 

aligned tab changes it to a decimal tab. 
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By pressing [Tab] the cursor moves to the next tab 

position to the right and the characters following it are 

aligned according to this tab. When editing text you can 

move to the next tab stop set in your text by using 

[Control][Tab]. 

60 



That's Write User Manual 

6. The menu bar 

In this section all commands are described in the order in 

which they appear in the menu bar. Each section begins 

with the name of the command being described as it 

appears in the menu. A full description of the command 

follows . 

* If a command is followed by three dots ( ... ), a 

dialogue box will appear after the command has been 

entered, in which you will be required to enter 

additional information in order to detail the 

command. 
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6.1 The File menu 

6.1.1 New 

SiiVI! 11; S 
Save as.,, A 
Save ASCII,,, U 

Daleta File... D 
Copu file. .. c 
Renar1e file.,, R 

Printer Type,,, T 
Print •• , P 
Mail Merge.,, M 

au 

[Control][F][N] 

That's Write 

This command deletes the text in the currently active 

window and should be used when you want to start a new 

document. It has absolutely no effect on files stored on 

your disk and only deletes the current text from the 

memory of the computer. 

To prevent accidental loss of your text the following alert 

box will be displayed if the text that you are going to 

delete from memory has not been saved to disk since the 

last changes were made to it: 
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Really delete text? 

[ffi] []!] 

The 'New' command will only be executed if you click on 

'OK'. 

6.1.2 Open ... 

Control][F][O] 

This command loads a text file from disk into memory and 

displays it in the currently active window. It can be used 

to load files that are in That's Write, Write ON, 1st Word, 

1st Word Plus or ASCII format. 

If the text currently in memory has not been saved, 

That's Write will warn you by displaying the following 

alert box: 

Abandon currently edited text? 

[ffi] []!] 

If you click on 'No' then the 'Open' command will be 

cancelled. 
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If you click on 'Yes' the text in the active window will 

be deleted and a file selector box will be displayed from 

which you can select a previously stored text file. If you 

try to load a file that was not created with That's Write 

the following alert box will be displayed: 

No That's Write do~u~ent! 

OK I lcan~ell 

If you choose 'OK' at this point, That's Write assumes 

that the file is an ASCII or 1st Word Plus text file. There 

are two conventions about the use of line and paragraph 

delimiters in ASCII text and you can choose between the 

two possible interpretations in the following alert box: 

V Find paragraph endings? 

ITill []2] 

* When you are loading text created by 1st Word Plus, 

the answer to the question 'Yes' or 'No' in the 'Find 

paragraph endings?' alert box will have no effect. 
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Select 'Yes' when every line of your input file is to be 

loaded as a complete paragraph . This applies to files such 

as program source code or the printer configuration source 

code used by That's Write (ie with a .PCS file identifier). 

Also select 'Yes' for text files which contain complete 

paragraphs on each line. This is a popular variant of the 

ASCII format for interchanging text between word 

processors and desktop publishing programs. 

Select 'No' when a paragraph in the ASCII file consists 

of several lines. In such cases two consecutive carriage 

return characters in the text are taken to be a paragraph 

ending. 

6.1.3 Insert ... 

[Control][F][I] 

'Insert' loads a file in a similar way to 'Open' except that 

the file which is loaded is added to the current document 

instead of it being replaced. Choose the file you wish to 

insert at the current cursor position from the file se lector 

box. 
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6.1.4 Last Version 

[Control][F][L] 

That's Write 

This command replaces the text currently in memory with 

the last version that was saved to disk so all the changes 

you have made since you last saved the text will be 

discarded. 

6.1.5 Save 

[Control][F][S] 

Text can exist on a disk in different files under a number 

of different names. 

This command saves the text under the name displayed in 

the information line. If a file with this name already 

exists on disk, the existing disk file's extension will 

automatically be changed to .BAK. You could click on 

the name in the information line and change it to another 

name prior to selecting the 'Save' command. 

6.1.6 Save As ... 

[Control][F][A] 

This command also saves the current text, the only 

difference being that a file selector box appears, enabling 

you to specify a new path or file name. 
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6.1. 7 Save ASCII ... 

[Control][F][U] 

User Manual 

This command saves the text in ASCII format . As already 

explained in the section on opening files there are 

different conventions for specifying line and paragraph 

breaks. Accordingly, you have two options for saving your 

text: either with or without a carriage return/ line feed 

character at the end of each line. 

CR/LF after ea~h line? 

ffii) Eru 

If you choose CR/ LF after each and every line the 

resulting file could for example, be shown or printed from 

the desktop. However, it may be difficult to use such a 

file as input to another program. If this is the case then 

you should select 'No' which will only give CR/ LF after 

each paragraph. 

ASCII format files do not contain information about text 

style, fonts or 'Page Layout ... ' so it is important that you 

always keep a copy of your document in That's Write 

format. 
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6.1.8 Delete File ... 

[Control][F][D] 

That's Write 

This command is used to delete a file from disk, it is a 

useful command when there is insufficient data space on 

the disk to save the current document. If you use this 

command you will be offered the file selector box from 

which you should select the file you wish to delete. At 

this point you can still cancel the delete command. 

6.1.9 Copy File ... 

[Control][F][C] 

This command will copy a file to another folder or to a 

different drive. First, using the file selector box, choose 

the file you wish to copy and click on 'OK' -a second file 

selector will appear - now select the file name and path 

you wish to copy to. 

6.1.10 Rename File ... 

[Controi][F][R] 

This command will change the name of a file on disk. 

Select the name of the file you wish to change from the 

file selector box and click on 'OK' -a second file selector 

will appear - now specify the new name. This function 

does NOT change the name of the file in memory. 
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6.1.11 Printer Type ... 

[Control][F][T] 

User Manual 

Because different printers have different commands for 

performing special functions a special printer 

configuration must be loaded for each printer that you 

wish to use. This command lets you change the currently 

selected printer configuration. As explained in Chapter 3, 

you must first install all of the different printers you 

wish to use. 

Printer drivers all have the file extension .TWP. If there 

is a file 'TWRITE.TWP' this will be the default printer 

driver loaded automatically when you load That's Write. 
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6.1.12 Print ... 

[Control][F][P] 

Print I neH.tH on 

FroM page 1/ to 'J'J'J 

Ho. of copies: 1 ~ 

That's Write 

HP DeskJet 

Only Rm1 ~ pages 

I double-sided I I flip nargins I 

footnote nur~bers by: Milit·M I I Text 

M!diM I I Hithout I pictures 
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Port: Printer (dtrec.tl 

Paper: MMM I Single I 

[ControlJ[A] 

[Control HE] 

[Control][O] 

[Control][W] 

[Control][U] 

[Control][D] 

[ Control][L] 

[Control][P] 

[Control][B] 

[Control][M] 

[Control][l] 

[Control][F] 

[Control][S] 

OK 

I Printer <BIOS) I I ModeM 11 file 

Cancel 

All 

Even 

Odd 

With 

Without 

Double Sided 

Flip Margins 

Printer (direct) 

Printer (bios) 

Modem 

File 

Feed 

Single 



That's Write User Manual 

You can decide how your That's Write document will be 

printed by setting the relevant parameters in the 'Print.. .' 

dialogue box. 

The first line of the dialogue box indicates the name of 

the file which will be printed and the printer it will be 

printed out on. You must specify the range of page 

numbers you wish to print. If you only want page 1 to be 

printed you should specify 'From page 1 to 1 '. If you only 

want to print page 2 you should specify 'From page 2 to 

2', etc. You can choose to print only odd or only even 

pages - a useful feature if you want to finish up with a 

document printed double sided. 

'No of copies' determines how many copies of each page 

will be printed. It is worth noting that with some printers, 

notably laser printers, printing several copies at a time is 

significantly faster than printing the whole document 

several times. 

You can also select the output port that your printer is 

connected to. In most cases the output port is the parallel 

port which is selected either by 'Printer (direct)' or 

'Printer (BIOS)'. For serial printers you should select the 

'Modem' port. 
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There are two options for printing to the parallel port: 

'Printer (direct)' is an especially fast That's Write 

printing routine, however it does not work in certain 

circumstances particularly if you use additional hardware 

or software such as a network or a printer spooler. 'Printer 

(BIOS)' uses the ST's standard method of printing which 

is compatible with other hardware and software that you 

may have in your machine but it is usually slower than 

printing direct. 

The 'File' option lets you re-direct all printer output to a 

disk file. This option is not available if the installed 

printer is an Atari SLM 804 Laser Printer. 

The 'Paper' option is used to specify the type of paper 

that you are using. 'Feed' is used for printing to fanfold 

paper or to cut sheet paper using a cut sheet feeder. 

'Single' is used for manually fed single sheet paper. In 

the latter case, That's Write will prompt you to insert a 

new sheet of paper when required. While your text is 

being printed an alert box indicates the number of the 

page being printed. 
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Printing can be interrupted or stopped completely at any 

time simply by holding down both [Shift] keys for a few 

seconds. Printing will continue for a short time and then 

That's Write will display an alert. box which will allow 

you to cancel printing. 

That's Write uses special automatically loaded printer 

fonts during printing. If That's Write fails to find italic, 

superscript or subscript fonts the relevant characters will 

be printed as normal text. 

* Because screen display is in a different resolution to 

printer resolution That's Write uses different fonts 

for displaying characters on screen to those it uses 

when printing. The display will accurately show 

where the line and page breaks will appear in the 

printed document but the position of the text on each 

line may vary between the screen display and printed 

output ie words that appear to be pedectly aligned 

beneath each other on the screen may not be so 

aligned when printed. If you want to align text on 

successive lines use (Tab]. 
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* That's Write requires a certain amount of free 

memory (RAM) when printing. If insufficient 

memory is available That's Write will terminate the 

printing operation and display an alert box. An alert 

box will be displayed if there is not enough memory 

to print an image. The image will be replaced by an 

amount of white space equivalent to the size of the 

image. If you do not have enough memory to print 

your document either use the 'Remove Font ... ' 

command from the 'Type' menu to delete any font 

currently loaded into memory that is not used in your 

document if you have used the spell checker, click on 

'End Checking' from the 'Edit' menu. Next try 

splitting your document into a number of files and 

printing each one separately. If this still does not 

give enough free memory, try removing some desktop 

accessories. 

6.1.13 Mail Merge ... 

[Control][P][M] 

Mail merge is a quick and easy way of sending 

personalised copies of the same letter to many people. 

The data for the merge needs to be in an ASCII file in a 

standard format called SDP or comma delimited. SDP is a 
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simple format and easy to create using That's Write. Most 

databases for the Atari ST can also produce SDF format 

files. 

The following is an example of a typical SDF format file: 

Powtech Keyton Ltd,J.P. Hartex,Connister House,"l29, 
Threpton Street",Tottenham,London N31,Mr 
Fowgraf Studio,H.F. Fowler,"30, Malplaquet Arcade", 
Hamilton Road,Maidstone,Kent,Mr 
Atterly Products Ltd,R. Pelham,"7,Tolliver Close", 
Barnsley,South Yorkshire,Mr 

If we were to mail merge using this file we would produce 

three different letters. That's Write automatically inserts 

the name and address into each letter. 

Looking at the above example you will begin to sec how 

an SDF format file is made up. Each of the three 

addresses is called a record and each individual 

component of a record eg H F Fowler is known as a field. 

There are 8 simple rules to follow when setting up an 

SDF file . 

a) Each record must contain the same number of fields. 
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b) Each field within a record must be terminated by a 

comma. 

c) The final field in a record must not be terminated by 

a comma. 

d) If a field contains a comma it must be enclosed in 

double quotes. 

e) Each record must end with a carriage return. 

f) There should be no carriage returns within a record. 

g) The maximum number of fields a record may contain 

is 128. 

h) The maximum length of a record is 80 characters. 

Look closely at the example again and see how it 

conforms to all of these rules. In the last record for 

Atterly Products, 7, Tolliver Close is enclosed in double 

quotes . Because this field is enclosed in double quotes 

That's Write will interpret the comma after the number 7 

as part of the field and not an end of field marker. 
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In the same record you will also notice that there are two 

commas after South Yorkshire. This is because Atterly 

Products address has one less field than the other records 

in the SDP file, each record must have the same number 

of fields so a blank field must be inserted into the record. 

The two commas make a blank field and hence the record 

has seven fields. 

Creating an SDP file in That's Write is very easy. 

Following the above guidelines, type in your data and 

save it in an ASCII file using the 'Save ASCII option 

from the 'File' menu. Enter the file name and select 'No' 

for 'CR/ LF after each line?'. 

Now we need to create a letter for our mail merge. A 

typical letter might look like this: 
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#1# 
Attention #7+##2# 
#3# 
#4# 
#5# 
#6# 

Dear#7##2# 

How are you? 

That's Write 

This note was written using the mail merge function in 
That's Write. 

As you know I have an Atari ST. That's Write is the best 
word processor I have found and I recommend that you 
buy one too! 

Yours sincerely 

Deborah Shipp 

Look again at the example That's Write document. Note 

how each field in the record is numbered consecutively 

and enclosed with a "#" mark. 
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* Each field will take on the font and style attributes 

as set for the field number and surrounding :f marks. 

Note that the field number and :f marks must have 

the same style and font. 

* If a [+] is placed after the field number, eg :fl +1, 

then if the field contains data a space will be 

inserted after the data, if the field is empty no space 

will be inserted. 

With the That's Write file on screen select the 'Mail 

Merge' option from the 'File' menu. A file selector 

prompts you for the name of the SDP file and this is 

followed by the print dialogue box: 

Print: 

aiD~ 

Selecting 'All' will merge all the records in the SDP file 

with your That's Write document and print it. 'Query' 

will display each record on screen and you can select 

from the dialogue box whether you want to print the 

record - 'Yes', ignore the record and display the next -

'No', or terminate the mail merge - 'Cancel'. 
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Print? 

Yes I I No lcanc.ell 

Thus your first letter would look like this : 

Powtech Keyton Ltd 
Attention Mr J.P. Hartex 
Connister House 
129, Threpton Street 
Tottenham 
London N31 

Dear Mr Hartex 

How are you? 

That's Write 

This note was written using the That's Write's mail 
merge feature. 

As you know I have an Atari ST. That's Write is the best 
word processor I have found and I recommend that you 
buy one too! 

Your sincerely 

Deborah Shipp 
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6.1.14 Quit 

[Control][F][Q] 

Select 'Quit' to exit That's Write and return to the GEM 

Desktop. As a safeguard, in case you failed to 'Save' one 

of the documents in memory, That's Write will draw your 

attention to the fact that you are exiting a document 

which has been changed since you last saved it by 

displaying the following alert box: 

V Really quit'? 

IVes I []!] 

If you click on 'No' you will return to That's Write and 

will still be able to 'Save' your document but if you click 

on 'OK' you will exit the program and any unsaved text 

will be lost forever. There is a choice in 'Prefe.rences' 

from the 'Options' menu to select a frequency of 

automatic, periodic saving that could be a great time 

saver if you do accidentally 'Quit' without saving. The 

worst thing that could happen then would be that text 

entered since the last automatic 'Save' would be lost. 
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* It is essential that you 'Quit' via the 'File' menu if 

the above safeguard is to operate correctly. Do not 

fall into the bad habit of switching the power to your 

computer off at the end of a session without having 

first correctly exited That's Write. 
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6.2 The Block menu 

To Clipboard B 
frDfl Clipboard L 

Copy C 
Hove H 
Delete D 
Save A 

Hide H 

To Start T 
To End 0 

User Manual 

A block is a piece of text which has been specially 

marked. It can range in size from one character to a whole 

document. Many operations, including deleting, moving, 

copying or saving text, can be performed on a block with 

a single command. 

6.2.1 Start 

[Control][B][S] 

or 

[AlternateHleft mouse button] 

or 

[Double click left mouse button] 
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6.2.2 Bnd 

[Control][B][E] 

or 

[Alternate][right mouse button] 

or 

[Double click right mouse button] 

A section of text must be defined as a block before a 

block command can be issued. This is done by using the 

'Block' menu commands 'Start' and 'End'. Only one 

block can be defined at a time and it is marked on the 

screen with a special background pattern: 

A block can be defined using either keyboard commands 

or the mouse. 

Using the keyboard position the cursor at the beginning 

of the block and use 'Start' from the 'Block' menu, move 

the cursor to the end of the block and select 'End' from 

the 'Block' menu. 
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There are several different ways to mark a block using the 

mouse. 

a) Point the mouse arrow to the beginning of the block, 

double click on the left mouse button then point to 

the end of the block and double click on the right 

mouse button. (This is perhaps the easiest method). 

b) Point the mouse arrow to the beginning of the block 

and press [AlternateHleft mouse button], then move 

to the end of the block and press [Alternate][right 

mouse button]. 

c) Position the mouse arrow at the beginning of the 

block, keep the left hand mouse button pressed down 

and move the hand and rectangle outline to the end 

of the block. This method can only be used for 

marking a block that is completely visible on the 

screen. 

d) Pressing [Shift] + left mouse button will mark the 

current word. 

e) Pressing [Shift] + right mouse button will mark the 

current paragraph. 
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6.2.3 Cut ... 

[Control][B][U] 

Use buffer 

Centel 

[Control] [1],[2],[3],[ 4] 

That's Write 

Blocks 1, 2, 3 and 4 

Just as you might cut an article out of a newspaper you 

can cut a block out of your text. Instead of being deleted 

the block that you cut out will be copied to a separate 

memory area (called a buffer). That's Write has four 

separate block buffers at its disposal and will ask you to 

select the one you wish to use for this operation. 

In this way you can cut up to four blocks out of your text 

without losing them. 
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6.2.4 Paste 

[Control][B][P] 

Use buffer 

mm mm 
[[] Cantel 

[Control] [ 1 ],[2],[3], [ 4] 

[Con trolHD] 

Blocks 1,2,3 and 4 

Delete 

Using the 'Paste ' command a buffered. block of text is 

pasted in at the current cursor position. The four buffers 

are available for use in both text windows. So you could 

for example 'Cut' a block out of one document window 

and 'Paste' it into the other. 

If you accidentally delete a block the deleted text is not 

totally beyond recall. Issue the 'Paste' command, click on 

'D ' in the dialogue box and the deleted block will be 

restored at the current cursor position. 
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* The 'Block' menu's 'Cut' command only stores the 

block in the computer's memory (RAM) not to floppy 

or hard disk. If you exit the program, switch the 

computer off or press the RESET button the buffers 

and their contents will be irretrievably lost. 

Furthermore, if you place a block into a buffer that is 

already occupied the previous contents will be 

discarded. 

6.2.S To Clipboard 

[Con trol][B HB] 

6.2.6 From Clipboard 

[Control][B][L] 

With these commands data can be transferred from one 

program to another. The clipboard is a folder on your boot 

disk or boot drive (if you have a hard disk). It is possible 

to copy text and pictures to and from the clipboard. 

6.2.7 Copy 

[Control][B][C] 

This command places a copy of a marked block at the 

current cursor position. 
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6.2.8 Move 

[Control][B][M] 

'Move' transfers a marked block to the current cursor 

position. 

* When the 'Block' menu commands 'Copy' and 

'Move • are being used the cursor must remain 

outside the marked block. Note that if the last line of 

a marked block is blank it will not be displayed as 

part of the block on screen because it contains no 

characters. 

6.2.9 I>elete 

[Control][B][D] 

'Delete' removes a marked block without further warning. 

If you accidentally delete a block it is possible to recover 

its original contents. See section 6.2.4 for further 

information. 

6.2.10 Save 

[ControiHB][Al 

'Save' lets you store the currently marked block on disk. 

The block can be saved in That's Write or ASCII format. 
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6.2.11 Hide 

[Control][B][H] 

This command removes the marking of the block. Once 

this command has been given no block exists so no block 

operations can be performed. 

6.2.12 To Start 

[ Control][B ][T] 

Moves the cursor to the beginning of a marked block. 

6.2.13 To End 

[Control][B][O] 

Moves the cursor to the end of a marked block. 
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6. 3 The Type menu 

,11\ file 
Pita 10tpi 
Hel 14 

./ Ti .. 12x 
Font 4 
Font 5 
Font G 
Font 7 
Font 6 
font 9 
font 10 

Dlotk Sty 
font 11 
font 12 
font H 
font U 
Font 15 
Font 16 
font 17 
font 16 
font 19 
font zn 

In That's Write a font is a particular typeface design in a 

particular size such as Elite 6cpi or Rock 18. 

That's Write can work with up to 20 fonts in memory at 

the same time. The fonts currently loaded into memory 

are listed in the 'Type' menu. 

After initial installation of That's Write you will see that 

only one font is listed in the 'Type' menu. 

6.3.1 Changing Fonts 

[Control][T][font number] 

Where the font number is between 1 & 9 for the 

first 9 fonts in the font list and 0 for the tenth 

font. 
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If no block is marked when a font is selected it will be 

used for newly entered text from the current cursor 

position. Any other text in the document will be 

unchanged. If a font is selected while a block is marked 

the marked text will be changed to the new font. 

The font that will be used for newly entered text is 

indicated in the 'Type' menu by a tick beside the font 

name. If you click on a different font in the 'Type' menu 

when no block is marked this becomes the active font. 

If you move the cursor along a line using [-+] the active 

font will be the font to the left of the cursor position. If 

you move the cursor backwards along a line using [+-] or 

re-position the cursor using the mouse the active font 

will be the font to the immediate right of the cursor. The 

font will change in the 'Type' menu to show the active 

font. 

6.3.2 Load font ... 

[ControiJ[T][L] 

Using this command you can load additional fonts at any 

time, provided the limit of 20 fonts has not been reached 

and enough free memory is available. 
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A complete font consists of four files; two for normal and 

italic styles and two for superscript and subscript size in 

normal and italic styles. Only the normal size/ normal 

style font is necessary. The fonts you load should always 

be from the TWRITE folder. The file name for these font 

files always start with an Sand have the extension .FNT. 

When That's Write is started any font(s) specified in the 

file 'FONTS' found in the 'TWRITE' folder are 

automatically loaded. 'FONTS' is a file in ASCII format 

and it must contain at least one font otherwise That's 

Write won't funCtion. When a document is loaded into 

That's Write all the fonts used in it will be loaded into 

memory automatically. 

If you would like a selection of fonts to be loaded 

automatically each time you load That's Write follow 

these instructions. 

From your ST's desktop, open the 'TWRITE' folder and 

note the screen fonts listed. (These are S*.FNT files and 

are created during installation and are not present on the 

That's Write Master Disks). Make a list of the fonts that 

you want to load automatically. In the folder you should 

also see a file named FONTS, take a backup copy of this 

file. Use That's Write to create a document that lists all 
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the fonts you want to load automatically (remember you 

must not exceed 20 fonts). Each font must be listed on a 

separate line as the following example shows; 

SYORK 

Sl5CPI 

SPICA 

SPROP 

SE LITE 

Save the document in the TWRITE folder, using the 

'Save ASCII' option from the 'File' menu, with the name 

'FONTS'. 

If you now 'Quit' That's Write, then reload it and check 

the 'Type' menu you should see all the fonts 

automatically loaded. During start up of 'TWRITE.PRG' 

you may find that some of your fonts will not be loaded. 

This is normally due to the listed fonts needing more 

memory than is available. If this is the case reduce the 

number of fonts listed in the file 'FONTS'. 
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* Fonts use a significant amount of memory (RAM). On 

Atari STs that have only 1MB of RAM they can 

easily take up so much space that the remaining 

memory is not sufficient for the text. If this happens 

u~ the 'Remove Font' command in the 'Type' menu 

to create more free memory. If you still find that you 

have insufficient memory try removing any desktop 

accessories that you may have installed including 

'TSNAP.ACC', 'FSEL.ACC' and 'KEYSHOW.ACC'. 

6.3.3 Remove Font ... 

[Control][T][Rl 

The 'Remove Font' command lets you delete a font from 

memory. This command is particularly useful if you need 

more memory to load an additional font or to add extra 

text to your document. 

Hel 14 
Til'l 1Zx 
SyMbol 
Box & Line 

Font.,, 

OK I Canc.el I 
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If you select the 'Remove font ... ' command you must 

choose a new font from the dialogue box for any text in 

your document that is currently set in the font that you 

are now going to remove. 

replac:e by .•. 

Pita lOtpi 
Hel 14 
TiM 17x 
b'J!t'l;y;) 

~ 

OK I Cancel I 

6.3.4 Show Fonts 

I Control J[T JlS I 

This command gives a quick impression of the fonts 

currently loaded. Each font can be displayed on screen in 

normal, italic, superscript and superscript italic . Press 

[N] to display the next font or [C] to cancel the function . 

(n)ext, (thntel 
~n::::':w:;:;Pa_ge,._ .. . ~~ld- ~~i .u: 
...L...............L._..... l.--... ........J...--
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6.4 The Style menu 

Layout Edit 
Fron Layout L 

--N~;~;i--------~--- N -
aold B 
Underlined u 
Double Underlined D 
Strike Through T 
Italit I 
Superstript P 
Substript S 

Mark Index X 
Mark Contents C 

The 'Style' menu commands allow you to change the 

style of your text, eg to highlight certain text passages. 

They can be applied to text in the following ways. 

a) Mark a block of text that you want to re-style and 

then select a text style from the 'Style' menu. In this 

way only the marked text will be re-styled. The block 

retains its original styles. The only way to remove a 

style from a block is to select normal - remember that 

this option will disable all styles.' 

b) Select a style for your text from the menu before you 

begin typing. In this way you can change styles as 

you type. Each style is on a toggle on/ off switch. If 

you select normal all styles will be disabled. 
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6.4.1 From Layout 

[Control][S][L] 

That's Write 

Click on 'From Layout' to reset the style of the marked 

block (or if no block is marked the current paragraph) to 

that defined in the paragraph style. (For further details 

refer to the section on 'Paragraph Style ... ' in the 'Layout' 

menu). 

6.4.2 Normal 

[Control][S][N] 

6.4.3 Bold 

[Control][S][Bl 

6.4.4 Underline 

[Control][S][U] 

6.4.S Double Underline 

[Control][S][Dl 

6.4.6 Strike Through 

[Control][S][T] 

6.4.7 Italic 

[ControlliSlfii 
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6.4.8 Superscript 

[Control][S][P] 

6.4.9 Subscript 

[ControlJ(S](SJ 

All style options can be freely mixed, with the obvious 

exception that 'Superscript' and 'Subscript' cannot be 

active at the same time. 

* To attain optimal print quality, That's Write uses 

extra fonts for 'Superscript' and 'Subscript' as well 

as 'Italic •. If either of these fonts is not available 

That's Write will print the relevant characters in 

'Normal' style instead. 

6.4.10 Mark Index 

[ControlHSHXl 

Marks a block of text for inclusion in an index built with 

the That's Write index function. 
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6.4.11 Mark Contents 

[Control][S][C] 

That's Write 

Marks a block of text for inclusion in a 'Table of 

Contents' built with the That's Write Table of Contents 

feature. 

1 
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6.5 The Layout menu 

Edit Options 
Paragraph Layout . •. A 
Page Layout.,, P 

ForNat Paragraph AQ 
ForNat Dotunent D 
Pagination 6 

Hide Paragraphs H 
ShON Paragraphs 0 

Load Layout.. . L 
save Layout •• , s 

The commands in this menu are concerned with 

formatting text. 

6.5.1 

or 

Paragraph Layout... 

[Control][L][A] 

[Control][A] 

Paragraph layout : ~ Body TeKt..--------------------

Headlng level : a lt ••Afih1MFIII!1!1i 

Justlftcattan : IJustlfted l IDIWIIM.mg:.J I Centered I IRiaht allanedl 

Default font : 1(>1 Til'l 12K 1<> 1 

Default style: I Itall~ I ~ I Underlined I I Supersc:ript I 
I Striked through 11 Double underlined I Subscript 

Paragraph separation I 8 fltft 

Line spacing: - [ill UJ [fi] [TI Delete 

I::2!L] I Canc:el I Ruler: L::lL: 8 pic:es 

[Control][t] Previous Layout 
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[Control][ .1.] Next Layout 

[ Control][F] Default Layout 

[Control][J] Justify 

[Control][L] Left Aligned 

[Control][C] Centred 

[Control][R] Right Aligned 

LControlJl+-] Previous Font 

[Control]L-+J Following Font 

[Control][I] Italic 

[Control][B] Bold 

[ControlHU] Underline 

[Control][P] Superscript 

[ControlHTl Strike Through 

[Control][D] Double Underline 

[Control][SI Subscript 

[Control][ I] Line Spacing 1 

[ControlH21 Line Spacing 1.5 

[Control][3l Line Spacing 2 

[ControlH41 Line Spacing 2.5 

[Control][5] Line Spacing 3 

[Control][-] Ruler-

[Control][-] Ruler+ 

These control commands are only available while the 

'Paragraph Layout. .. ' dialogue box is being displayed and 

are used instead of the mouse to select options. 
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The first line of the 'Paragraph Layout...' dialogue box 

contains the name of the 'Paragraph layout' (maximum 

two letters) and is followed by an optional explanatory 

comment. To select another 'Paragraph layout' click on 

the arrows next to the paragraph layout name. 

'Heading level' can be a value between 0 and 9. It is used 

by 'Hide' and 'Show' paragraphs as explained in Sections 

6.5.6 and 6.5.7 and by the 'Table of Contents' generator 

as explained in Section (6.6.8). 

The 'Default layout' button in line 2 is used to make the 

current 'Paragraph Layout' the default layout, ie each 

time [Return] is pressed this layout becomes active for 

the new paragraph. Only one 'Paragraph layout' can have 

this default attribute. If you click on 'Default layout' 

when another paragraph style is currently defined as 

default the current layout will become the default and 

the other style will automatically revert to having 

'Default layout' set off. You can opt to have no default 

layout at all in which case any new paragraph that you 

create will have the same layout as the previous one. 
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The default font and style will be used unless overridden 

by an option from the 'Type' or 'Style' menu. Obviously 

only one default font can be selected while several style 

options can be combined. 

Paragraph separation allows you to insert additional space 

before the paragraph. Space is inserted in all paragraphs 

except those that are the first paragraphs of a new page. 

'Line spacing' gives the factor by which the largest font 

size in each line of the paragraph is multiplied to give 

the line spacing. 

Under 'Ruler' you can change the ruler which is 

displayed at the top of each text window. Using the + and 

- keys you can select the option you wish to change from 

the following: 

left margin 'L' 

first line indent of a paragraph, ie indentation 'L" 

right margin 'R' 

tab positions and types of tab 'Tab' 
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To delete a tab set its position to 0. 

To change the type of Tab click on the Tab type eg to 

change from ' left' to 'centred' click on the word 'left'. 

To change the dimensions of Tab stops click on the 

dimension eg 'picas' to 'cm'. 

The meaning of these options is discussed in Chapter 5 

together with a description of how to change the ruler 

settings by using the mouse 

Click on 'Delete' to delete a 'Paragraph Layout' that you 

no longer need. 

* MAKE SURE that the right margin of the ruler in a 

paragraph NEVER exceeds that of the 'Page Layout". 

In 'Page Layout ... • you define the maximum settings 

for the page and in 'Paragraph Layout ... • you define 

how the paragraph will look in relation to the page. 

* If you delete a 'Paragraph Layout ... • any paragraph to 

which it was assigned will be given the default 

layout. For this reason, it is IMPOSSffiLE to delete 

the default layout. If no default is defined the first 

layout defined can't be deleted. 
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6.S.2 •page Layout ... • 

[Control][L][P] 

or 

[Control][Pj 

That's Write 

'Page Layout...' defines the position of the text on the 

page. 

Page layout: I <-I Pil l o I ----------------------------------------

Paper length: 67 lines Paper ~o~idth: 58 pir.as 
~ 

Left l'largin: 6 pitas Right l'largin : 5 pir.as 

Top r~argin: 24 lines TOF l'largin: 21 lines 

Bottol'l 111argln: 4 lines Foot l'largln: 2 lines 

No. of tolunns: 1 ' distanr.e: 3 pir.as 

Nur~ber of lines at start 1, at end of paragraph 1 

Footnote dlstante: 1 lines 

Separation line length: 0 pir.as !Left-Head!! Header 

lLeft-Foot ll Footer ~ I Cantel I Delete 
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[Control][t] 

[Con troiHD] 

[ControllLF] 

[ControlHHJ 

[Control][L] 

[Controi][T] 

Next Layout 

Previous Layout 

Delete layout 

Change Footer 

Change Header 

Change Left Header 

Change Left Footcr 
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The above commands can be used to alter settings in the 

'Page Layout...' dialogue box. 

There are some limits to the values that can be entered. 

* The maximum width of a page is 20 inches (50cm), 

the maximum page length is 40 inches (1 metre). 

All dimensions must be consistent with each other. For 

example, the total width of the left and right margins 

cannot be larger than the total width of the page. If you 

make a mistake of this kind, the following alert box will 

ask you to correct the faulty parameters. 

t4IIV Layout inpossible! 

OK 

For convenience, several units arc available for each 

quantity. By clicking on a displayed unit you can switch 

to another one. The available units are inches 

centimetres and 'lines' for vertical distances (a line 

being 1/ 6 inch), inches, centimetres and 'picas' for 

horizontal distances (a pica being 1/ 10 inch). 
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Lines and Picas are the standard height and width of a 

character on a basic typewriter. 

Multiple columns can be setup for a page. All columns 

are of the same width and are separated by the setting 

'distance'. On screen you will see the columns displayed 

underneath one another as galleys, however on printout 

they will be printed next to each other. 

You can select the number of lines to be kept together at 

the start and end of a paragraph, eg if you set these to 3 

pagination will never put less than 3 lines of a paragraph 

on one page unless the paragraph is very short. 

Headers and footers are also part of a 'Page Layout. .. '. 

Each 'Header' and 'Footer' cai1 be of arbitrary length and 

content subject to the restriction that it must fit into the 

space assigned to it by the various margins. By clicking 

on the 'Header' or 'Footer' button the header or footer is 

displayed in the text window ready for editing or for 

creation. You can switch back to your main text using the 

'Main Text' command from the 'Edit' menu . 

Selecting 'Left-Head' or 'Left-Foot' allows you to specify 

a separate header or footer to be printed on left hand 

pages. 
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* Make sure that the size of the header or footer is no 

larger than the space set for it in the 'Page Layout ... ' 

otherwise it will be truncated. 

Footnote distance specifies the space between the last 

line of text on a page and the start of a footnote. 

Separation line distance is the length of the line printed 

between the end of the text and the first footnote. Set 

this to zero if you do not want a separation line. 

Selecting 'Delete' will delete a 'Page layout' that is no 

longer needed. All documents created using this layout 

will be assigned the first 'Page layout' ever created 

which cannot be deleted. 

The 'Page layout' has priority over all paragraph layouts 

so for example if you specify only 60 characters per line 

as a maximum in 'Page Layout...' but 70 in 'Paragraph 

Layout...' the extra 10 characters will be CUT OFF when 

printed. The maximum width of a line as set by the 'Page 

Layout...' is indicated in the ruler line by a small 

vertical line. 
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* If you use That"s Write to best effect you should very 

rarely have to use more than one carriage return 

consecutively in your document - the insertion of 

space should be a feature of the Page Layout and 

Paragraph Layout. 

6.5.3 Format Paragraph 

[Control][Q] 

6.5.4 Format Document 

[Control][F][D] 

These two commands reformat your text, ie they 

re-arrange the words either in the paragraph in which the 

cursor is positioned or the whole document so that they 

correspond to the settings in the page and paragraph 

layouts. 

Text is automatically formatted as you enter it. However, 

if you edit the text by inserting or deleting characters or 

change the page and paragraph layouts the text may need 

to be rcformatted. 

'Format Paragraph' will rcfonnat the entire paragraph in 

which the cursor is placed. 'Format Document' will 

reformat the whole document. 
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It is not necessary to reformat your text each time you add 

or change text but you should make sure that the whole 

document is formatted before proofing otherwise the 

printed result may not match the screen display. 

If you prefer you can leave all the formatting to That's 

Write by selecting 'Automatic Formatting' from the 

'Options' menu. However, for text with long paragraphs 

this can take a considerable amount of time so you might 

find it easier in these cases to use the 'Format Paragraph' 

and 'Format Document' commands to control formatting. 

6.5.5 Pagination 

[Control][L][G] 

'Pagination' calculates the positions in the text where a 

new page will begin. This is in fact part of the 

reformatting process and for this reason the 'Format 

Document' option includes 'Pagination'. However, if you 

use 'Format Paragraph' or 'Automatic Formatting' then, 

to speed up the screen refresh time, no pagination is 

performed. Therefore, the page breaks shown in the far 

left column of a text window may not always be at their 

proper position. Use this command if you need to know 

the correct page break positions. 
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You also have the option of having pagination performed 

automatically by selecting 'Automatic Pagination' from 

the 'Options' menu. 'Pagination' may take a few seconds 

for long documents so it is recommended that 'Automatic 

Pagination' is only used for documents with less than 

five pages. 

6.S.6 Hide Paragraphs 

[Control][L][H] 

6.S.7 Show Paragraph 

[Control][L][O] 

These two options work in conjunction with the 'Heading 

level' in the 'Paragraph Layout ... ' dialogue. 

Issuing the 'Hide Paragraph' command once stops the 

screen display of paragraphs with the lowest defined 

'heading level'. Issuing a second 'Hide Paragraph· will 

suppress those with the next lowest 'heading level' etc. 

'Show Paragraph' has the opposite effect. This is very 

useful when switching between a document viewed in 

detail and in outline. 
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A marked block of text will include all text within the 

block that is hidden so that it is easy to move large 

sections of a document. 

If some of your That's Write document is hidden the 

current level being displayed is shown in the Info line. 

6.S.8 Load Layout ... 

[Control][L][L] 

6.S.9 Save Layout 

[Control][L][S] 

With the 'Load Layout...' and 'Save Layout' commands 

you can create a collection of page and paragraph layouts 

for each different paper size and document style that you 

routinely use. 

'Save Layout' saves all page and paragraph layouts as 

defined in the current text as well as headers and footers. 

Selecting 'Load Layout...' will load a layout file that you 

have created. The individual paragraph styles from the 

file are added to those already defined and replace those 

which have identical names. Paragraphs modified by this 

process are reformatted at the same time. 
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Suppose you are writing a long document and you need to 

print draft copies for proof reading followed by a final 

copy. By taking the following steps you can get a fast 

draft print followed by a final copy. 

Begin by writing your text in a simple Pica font and 

printing it out onto fanfold paper without headers or 

footers. When you are satisfied with your document and 

want a final print out on single sheet paper (which may 

have a different size), using a proportionally spaced font 

for the main text and a larger font for the headings then 

you will only need to change the page and paragraph 

layouts. 

This can easily be done by creating two layouts each 

with the same page and paragraph layout names. By 

modifying the 2 layouts appropriately it is both quick and 

easy to switch between draft and final print modes; the 

document is automatically reformatted to the changed 

style. 

If a layout file with the name 'TWRITE.LA Y' is placed 

in the 'TWRITE' folder it becomes the default layout and 

is automatically loaded whenever That 's Write is started 

or whenever 'New' is selected from the 'File' menu. 

114 



That's Write 

6.6 The Edit menu 

Foot- I Endnote ON 
Hoin Text H 

Indent Ins 
Page Nu~ber... P 

Table of Contents T 
Index I 

Load IH6... L 
Delete IH6 D 

Check Spelling AC 
End Checkln 0 

User Manual 
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6.6.1 Search ... 

[Control][E][S] 

That's Write 

find: ~-----------------------------
Direction: 

Mi.Ji~61i.M I Backward I 

Case: 

Match Mi.IUUAM 

CoMplete HOI"ds: 

Yes 

OK I Cancel I taunt 

[Controi][F] Forward 

[Control][B] Backward 

[Control][M] Match 

[Control][l] Ignore 

[Control][Y] Yes 

[Control][N] No 

[Control][ C) Count 

'Search ... ' is used to find a given sequence of characters 

in the text. That's Write will begin to search from the 

current cursor position and proceed in the direction 

selected. 
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You can choose whether upper and lower case characters 

are looked upon as being the same by selecting 'Ignore' 

or not the same by selecting 'Match'. In most cases 

' Ignore' is the most suitable. 

'Complete words' lets you specify whether you want to 

find all occurrences of the given character sequence or 

just complete words. In the latter case 'Match' searching 

for "the" will only find the word "the", while 'Ignore' 

will find "they" and "Athens" in addition to "the". 

Unlike some other word processors That's Write treats 

hyphenated words as one word so you can be sure that all 

occurrences of the character string that you are looking 

for will be found. 

You can make use of a Wild Card f*l during 'Search'. 

This character will match to an arbitrary letter in the 

text eg searching for "*e" will find "Toe" and "The" but 

not "Tone". 

Count will give the number of occurrences of a particular 

word from the current cursor position either 'Forward' or 

'Back'. 

117 



User Manual 

6.6.2 Repeat Search 

[Control][R] 

That's Write 

Having found the first occurrence of a string use 'Repeat 

Search' to find the next occurrence using the settings of 

the last issued 'Search' command. 

* This function works on both •search • and •Replace •. 

6.6.3 Replace 
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[Control][E][R] 

Replate: ~-----------------------------
By: 

Direttion: 

. Case: 

Matth Mi.IU.iiM 

Cortplete ~o~ords: 

Yes 

1!.!4. Query All 

[Control][F] 

[Control][B] 

[Controll[M] 

OK I I Cantel I 

Forward 

Backward 

Match 
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[Con trol][I] Ignore 

[Con trol][Y] Yes 

[Control][N] No 

[Control][O] Once 

[Control][Q] Query 

[Control][Al All 

This command works in the same way as 'Search' except 

that That's Write replaces the searched for characters 

with other nominated characters. Insert the character 

string to be searched for in the first line of the dialogue 

and the replacement character string in the second line. 

Using the 'Replace' command you can either select 

'Once' which will replace only the first occurrence of the 

character string, 'Query' which will prompt you to 

optionally replace on each occurrence or 'All' which 

replaces every occurrence. 

When you select 'Query' the cursor will stop at each 

occurrence of the string. Enter [Y] to replace the string or 

[N] to keep the old one. To cancel the replacement 

process type [C]. 

To stop the automatic replacement of 'All' occurrences, 

press both [Shift] keys at the same time. 
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6.6.4 Foot-/Endnote 

[Control][F] or [Control][E] 

A footnote is a reference mark placed in the text to a 

reference printed at the bottom of a page. 

To insert a footnote at the current cursor position click 

on 'Foot-' in the 'Edit menu'. A blank screen will appear 

with the footnote number in the top left hand corner in 

which you can type a footnote. 

That's Write automatically renumbers footnotes and 

automatically paginates the document so that the 

footnote number and its associated text fit on the same 

page. 

An Endnote is similar to a footnote except that the text of 

the Endnote appears at the end of the document rather 

than the end of a page. To insert an Endnote into your 

document click on 'Endnote'. 
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11\ File T 
Endnate 

2 

[ I] 

To edit a footnote or Endnote, position the cursor 

immediately to the left of the footnote or Endnote and 

click on either 'Foot- ' or 'Endnote'. 

To delete either a footnote or an Endnote, position the 

cursor immediately to the right of the footnote or Endnote 

and press [Backspace]. 

6.6.5 Main Text 

[Control][E][M] 

Use the 'Main Text' command from within headers, 

footers, footnotes or endnotes when you want to return to 

the main text. 

6.6.6 Indent 

[Insert] 

'Indent' allows you to block part of a paragraph away from 

the left margin. When you press [Insert] the cursor will 

move to the next 'Tab' stop and all text typed until 

[Enter] is pressed will have its left margin set at the 
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[Tab] stop. This would appear to be the same as using the 

[Tab] key except that if text exceeds the right margin of 

the 'Paragraph Layout...', text on the next line will 

automatically indent to where you began typing after 

having pressed [Insert]. 

eg I have pressed [Insert] after the eg at the start of this 

paragraph and continued typing. I shall now start a 

new paragraph by pressing [Enter]. 

This is the start of a new paragraph. 

6.6. 7 Page Number 

[Control][E][P] 

Mu111ber of 

current I !folloHinAI 

page lit 

This command inserts a special symbol into the text that 

will be replaced by the number of the page on which it is 

located when the document is printed. This can be used 

in headers or footers to print a number on every page. You 

can choose between numbering with the 'Current page' 

number or the 'Following page' number. Following page 
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is useful when creating documents that will have a 

separate front sheet and the document needs to be 

numbered starting with the second sheet of your 

document as page 1. 

6.6.8 Table of Contents 

[Control][E][T] 

This option automatically generates a table of contents 

and inserts it at the end of your document. 

All blocks of text marked using 'Mark Contents' from the 

'Style' menu will be included in the table of contents. 

Additionally, you can specify all paragraph styles with 

heading levels above a certain level to be included in the 

table of contents. This option is specified when you click 

on 'Table of Contents' and get the following dialogue 

box: -
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Heading level: ~ 

I OK I I Cante I I "' 

Select the lowest heading level to include in the table of 

contents and click on 'OK'. 

The table of contents will now be generated 

automatically. At the same time a paragraph style TC 

will be automatically generated and all entries in the 

table of contents will be assigned that paragraph style. 

* If you have already created a style TC for the table of 

contents, mark the whole of the newly generated 

table of contents and click on •From Layout' ia the 

•style • menu to apply the style to the new text. 

* If you want to save the table of contents at the start 

of your document and want page numbering to 

include the table of contents, first insert the 

appropriate number of hard page breaks at the 

beginning of your document then generate the table 

of contents and move it to these blank pages. 
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* If you want the table of contents at the beginning of 

your document but want to start the numbering of 

your document from the first page of your text 

following the table of contents then set the page 

number offset as a negative number equal to the 

number of pages that you want to be left 

UN-numbered at the beginning of your document. 

(When using a negative "Page Number offset" the 

printing of "Page Number• is suppressed for pages 

before page 1.) 

6.6.9 Index 

[Control][E][I] 

'Index' works in a very similar way to 'Table of Contents' 

except that all paragraphs created by 'Index' have their 

paragraph style set to the default paragraph style. 

* Experiment with table of contents and index 

generation before you use them in an important 

document. Both "Index" and "Table of Contents• are 

very powerful features which automate very complex 

manual operation. For optimum results their use 

needs to be carefully thought through when you arc 

first planning the layout of your document. Apart 

from experiments. leave generating the index and 
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table of contents to the very last operations you 

perform on your document before final printout. 

6.6.10 Load IMG ... 

[Control][E][L] 

That's Write works with pictures as well as text. Software 

for the Atari ST uses several different formats for 

pictures, That's Write will import pictures in .IMG 

format. 

If you want to load a picture into That's Write you must 

first make sure that it has been converted to .IMG format. 

In That's Write, a picture always takes up a complete 

line. When a picture is loaded it is placed at the left 

margin on a line immediately below the cursor. 

The picture can be moved horizontally with the mouse by 

positioning the mouse arrow on the picture , holding the 

left mouse button down and dragging the picture to a new 

horizontal position. 
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To move the picture vertically use the block functions. 

You can change the size of a picture by changing its 

resolution. First double click on the picture ; the 

following dialogue box will appear. 

Resolution Cdpil: 

horizontal: 17~ vertical: 183 

I tloni tor I Printer I 

MiiAili& save I I OK 

The resolution gives the number of dots of the picture 

that fit onto one inch of paper when printed or onto one 

inch of screen when displayed. That's Write 

automatically rescales the picture in such a way that its 

size remains the same on screen as when printed out. To 

increase the size of the picture, decrease the resolution. 
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Similarly, to decrease the size of the picture, increase the 

resolution . 

You can either enter the required resolution to fit the 

picture into a specific area manually or you can select 

'Monitor' for 90 * 108 dpi or 'Printer' for the resolution of 

the currently loaded printer configuration. (The actual 

resolution of your screen depends on your monitor). 

Selecting 'Printer' will usually give the best quality 

print out of your .IMG file. 

You can also increase or decrease the picture's size by 

clicking on its bottom right corner, holding the left 

mouse button down and dragging the picture to the 

appropriate size. 

. ...................................... "'l 

I 

l 
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6.6.11 Delete IMG 

[Control][E][D] 

User Manual 

This command deletes a picture from your text. To use it 

place the cursor on the line above the picture, click on 

the drawing and the cursor will be placed automatically 

above the picture, then select 'Delete IMG'. 

Before executing this command That's Write displays the 

following alert box. 

Delete picture? 

ffii) []!] 

The picture will only be deleted from the current 

document not from disk. The image can also be deleted by 

placing the cursor directly after the picture and pressing 

[Backspace]. 

6.6.12 Check Spelling 

[Control][ C) 

'Check Spelling' will check the spelling of the words in 

your document against those in the dictionary from the 

current cursor position to the end of the document or, if a 

129 



User Manual That's Write 

block is marked, the words in that block. When you first 

issue this command, That's Write will load a dictionary 

into memory from disk. If the dictionary is not in the 

folder set in 'Preferences ... ' from the 'Options' menu 

then you will be prompted to locate the main dictionary 

file *.DSK. 

* Note that the dictionary file that is loaded must be 

the same language as set for hyphenation in the 

'Language ... • option from the 'Options' menu. 

If That's Write finds a word that is not in the Dictionary 

the following dialogue box will appear:-
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Correction 

eesu I ul.---------------------------------------------

Ill I I Cancel I 

[Control][S] 

[Control][l] 

[Control][A] 

[Control][ 1 ],[2], ... L6] 

Insert I A 1 ternet Ives I 

Stop 

Insert 

Alternatives 

Alternatives 1 to 6 
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Clicking on 'OK' will replace the original word with the 

one from the first line of the dialogue. 'Cancel' will 

leave the word unchanged and spell checking will 

continue. 

'Stop' will leave the word unchanged and stop spell 

checking. 

'Insert' allows you to insert the word either into the main 

That's Write dictionary or into a supplementary 

dictionary. When you click on 'Insert' the following 

dialogue will appear:-

Correction 

Rrl' 

Insert ward 

Hr i ghtan~--------------------------------------------
1 Haln dictionary I I Supplenent I Lli!i@ 

OK I I Cancel I Insert I A I ternatl ~es I 

* As a general rule it is better to insert words into a 

supplementary dictionary. 

Click on 'Alternatives' and That's Write will check for 

similar words in the dictionary that closely match the 
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word that has been potentially mis-spelt. You can keep 

clicking on 'Alternatives' and more close matches will be 

shown until the 'Alternatives' button becomes grey. 

* Dictionaries are available for That's Write in many 

languages... if you want to purchase additional 

dictionary disks please call the Helpline. 

6.6.13 End Checking 

[Control][E][Q] 

'End Checking' removes the currently loaded dictionary 

from memory creating more space for your document, 

fonts or pictures. 
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6. 7 The Options menu 

,, 
I AutOMatic ForMatting F 

AutoMatic Pagination A 
DverHrite Mode AJns 

I Show IM6s I 
IMMediate Checking c 
Hyphenation/Correction.,, H 
Preferences.,, P 
Language,,, N 

Load Macro. , , 
Save Macro •• , 

6.7.1 Automatic Formatting 

[ControlJ[O]LF] 

L 
s 

User Manual 

When 'Automatic Formatting' is switched on That's 

Write will automatically reformat each paragraph that is 

altered whenever you have not typed text for more than 

two seconds. 

6.7.2 Automatic Pagination 

[Control][ 0 ][A] 

When this option is activated That's Write checks the 

location of page breaks every time a line is added to or 

removed from the text. 

'Pagination' always occurs before a document is printed. 
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* Since • Automatic Formatting• and •pagination • are 

time consuming it is usually more convenient to 

de-activate them when working with long documents. 

6.7.3 Overwrite Mode 

[Control][Insert 1 

Normally, all characters that are typed from the keyboard 

are inserted into the text; any text to the right of the 

cursor is pushed to the right. This is called insert mode 

and is usually the most convenient way of typing. In some 

circumstances however, it is more convenient if each 

letter typed replaces the letter to the right of the cursor. 

This method of entering text is called 'Overwrite Mode'. 

That's Write offers both modes and [Control][Insert] is 

used to toggle between them. 

6.7.4 Show IMGs 

[Control][O][I] 

Pictures, especially large ones, take up an enormous 

amount of space in memory. Conversion of pictures to the 

screen resolution can take a long time - this is 

particularly noticeable when loading a document from 

disk that contains many pictures. That's Write gives you 

the option of switching the display of pictures off saving 
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both time and memory space, an outline of the proper 

picture size is displayed instead. All operations on 

pictures function normally except that you cannot see the 

contents. You can switch the display on again at any time 

if you wish to see the pictures again. 

6.7.5 Immediate Checking 

[Control][O][C] 

If you switch 'Immediate Checking' on, That's Write will 

spell check as you type. If you type a word that is not in 

the dictionary That's Write produces a special tone to 

warn you of a possible spelling mistake. 
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6.7.6 Hyphenation ... 

[Control][O][H] 

Hyphenation 

Autol'letl t l't Sel'l i -autlll'llltl t 

Manual I IIDaDII I Dittionarw I 
Hinii'IUI'I of Nhite spate: Jr. 

Fill I'"J.Sih1s r-es~rved 

OK I I Cantel I 

[Control][A] Automatic 

[Control][S] Semi -automatic 

[Control][M] Manual 

[Control][O] Off 

[Control][Y] Auto Correction -Yes 

[Control][N] Auto Correction - No 

To fill each line with a reasonable number of characters 

it is sometimes best to hyphenate some words depending 

on the nature and style of the document. 
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Automatic: 

Semi-Automatic: 

Manual: 

Off: 

User Manual 

That's Write hyphenates words 

automatically, without asking for 

confirmation. 

That's Write suggests a position 

for hyphenation which you may 

ignore, comply with or change. 

That's Write stops at every word 

that will not fit onto a line; you 

decide where the word should be 

hyphenated. 

That's Write will not hyphenate 

any words at all. 

You can control the amount of hyphenation that occurs 

by specifying the minimum percentage of white space a 

line should have; a page usually looks best with a 

balance between additional white space being inserted 

between words and words being hyphenated. As you 

increase this value the amount of hyphenated words in 

your document will decrease and the more spacing 

between words will vary on different lines. 
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During formatting in semi automatic or manual mode, 

That's Write will display its suggestion for hyphenation 

or the last possible hyphenation position in the following 

alert box: 

Hyphenation 

1<>1 pr1n"'ters I o I 
OK Ho I Cantel I 

By clicking on the left or right arrows or by using 

[Control] and the cursor keys you can move the 

hyphenation point to the left or right in the word being 

checked. The positioning of the hyphen applies only to 

the word in the box; it is not used as a pattern for the 

position of hyphens in words of a similar size. By 

clicking on 'OK' the word will be hyphenated exactly as 

it is displayed. You can stop hyphenation by clicking on 

'Cancel' or by pressing [Control][ C) (the remainder of the 

formatting will be done without hyphenation). If you 

click on 'No' or press [Undo] the word will not be 

hyphenated and will be placed on the next line. 
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When 'Automatic Formatting' is activated at the same 

time as semi-automatic or manual hyphenation, no 

hyphenation is performed during 'Automatic Formatting'. 

If you want to hyphenate the text select 'Format 

Document' when you have finished typing. 

Switching 'Automatic correction' to 'ON' will 

automatically correct simple capitalization errors as you 

type. For example if you type 'London' That's Write will 

automatically change it to 'London'. 
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6. 7. 7 Preferences ... 

[Control][O][P] 

Preferences 

conflrl'lattans: - c::::JiL::J 
Path to external files: E: \ TWBETA\ TloltiTE\~------------------

Addl tlonal dictionary: E: \TWBETA\TioltiTE\EXTRA , USIL-----------

Save every 0 111inutes 

Co111nands: 

Detinal tharatter : 

[Control][Y] 

[Control][N] 

[Control][l] 

[Control][2] 

[Control][,] 

[Control][.] 

[Controi][S] 

-CD 
c=J -

Confirmations on 

Confirmations off 

Use That's Write 

command set 

Use Wordstar command 

set 

Decimal sign is a , 

Decimal sign is a . 

Save preferences 

Using the 'Preferences' dialogue box you can set some 

important parameters for using That's Write which can be 

saved to be automatically used every time That's Write is 

loaded. The first line of the dialogue box refers to the 

confirmations required for operations that may cause 
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irrecoverable loss of data, such as deleting text. You can 

switch these confirmations off, but you should only do 

this if you are familiar with That's Write and are not 

working with an important document. 

The default path to external files is set automatically 

during 'Installation' . You can change it for special 

configurations eg having the main That's Write program 

on different disks or hard disk partitions from the external 

files (fonts, printer configuration files, dictionary etc). 

If you set 'Save every x minutes' to 10 minutes, no matter 

what happens, even power failure or hardware failure you 

will lose no more than 10 minutes work. When working 

with floppy disks however, you could decide to switch 

this function off (by entering 0 minutes) because saving 

to floppy disk takes a considerable time and can be 

distracting. 

'Commands' switches between using the That's Write 

quick keys setting '1' or a Wordstar like command set '2'. 

The Wordstar command quick keys are given in Appendix 

1. The character used for a decimal varies according to 

local customs. You can set the decimal character used by 

decimal tabs to either '.' or ',' by changing the 'Decimal 

character'. 
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If you click on the 'Save' button the current preferences 

will be saved in a file called 'TWRITE.INF'. 

'TWRITE.INF' contains the options entered in this 

dialogue box and the items from the Option menu. Each 

time you load That's Write all the options are set as 

specified in this file. 

6.7.8 Language 

[Contro][O][N] 

The 'Language' option sets the particular language 

hyphenation rules to be used for a particular document. 

That's Write is supplied with rules for a number of 

different languages. 

* Note that if you intend to use a dictionary to spell 

check your document the 'Language' selected for 

hyphenation should be the same as the language of 

the dictionary. 
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6.7.9 Load Macro ... 

[Control][O][L] 

This command loads a file with the extension '.MAC', 

which contains one or more macros. 

Load l'lac.ro 

E:\TWBETA\TWRITE\*.HAC----------------

Dri11e 

rnrnrn 
mm 

•I• ""~'!'.j!,1'" !!* , HR C fi!! Himnl"'l""!! 
.2. 

I [+J EPSLQ 
~ [+J HPDJ 
3 [+J STARLC 
~ [+J TVPEWRIT 
1~ TWRI~ .HAC 

File: ~------- · --
OK I I Canc.el I 

Select the macro file that you wish to load from the above 

file selector box. The alert box that follows gives you the 

choice of retaining or deleting any old macros: 

Delete old Mac.ros? 

Programming and use of macros is explained in Chapter 8. 
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If a macro file with the name 'TWRITE.MAC' is placed 

in the folder 'TWRITE ', it will be loaded automatically 

each time That's Write is started. If this file contains a 

macro definition for the [Esc] key this will be executed 

automatically. 

6. 7.10 Save Macro ... 

[Control][O][S] 

All macros currently in memory are saved as a file with 

the extension .MAC. 
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7. Other Commands 

Some extra commands are available via The Information 

Line or via the keyboard. 

7.1 The Into line 

11\ file 
neHatH 

J. 2 

The Info line is the line directly below the menu bar. It 

contains general information about how That's Write is 

set up. 

From left to right the Info line incorporates the following 

fields: document name, 'Page Layout...', · paragraph 

layout, mode indicator, caps lock indicator, heading level 

indicator, position of cursor (by page, line and column), 

and four arrows. You can change the information that 

most of these fields contain by clicking on them. 
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By clicking on the document name or typing 

[Control][D][N] a dialogue will be displayed giving 

information about the document. 

Nane: neH.tH~----- ~ ------------ <> ------------
Page nunber offset: 0 Footnote nunber offset: 0 

Password: --------------------

Author: ---------------------------------

Connent: ----------------------------------------
Creation: 07.03.91 1•:51 

OK I Cantel I 

The document file name can be changed by changing the 

'Name' field. It is not possible to change the folder using 

this form - use 'Save as' from the 'File' menu to do this. 

The next two fields allow you to chain multiple 

documents together such as the chapters of a book. The 

first of these fields indicates the preceding document and 

is automatically updated by That's Write. The second 

field, indicated by a forward arrow, indicates the next 

document in the sequence and this you shou ld enter. 
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Once you exit this dialogue, the key combination 

[Control][G][+] will automatically save the current 

document and move to the next document. This process 

also automatically updates the 'Page number offset' and 

'Footnote number offset' (see below for details) in the 

newly opened document so that when printed the separate 

documents have consecutive page numbers and footnotes. 

Similarly, you can scroll back through the chained 

documents using [Control][G][-]. 

'Page number offset' is a number added to the current 

page number at print time. For instance, if you want the 

first page in your document to be page 23, set the 'Page 

number offset' to 22. 

It is possible to start numbering your document with a 

page other than the first page as page 1. For instance you 

might have a table of contents occupying the first three 

pages of a document and the fourth page the start of your 

text. If you set the page number offset to -3 then page 

numbering will start on the fourth page of your document 

as page 1. 
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The 'Footnote number offset' works in a similar way to 

'Page number offset' to control the starting footnote 

number of the current document. 

If you set a 'Password', each time that you load a 

document you will be asked to type the Password before 

the document is displayed. 

(If you do assign a 'Password' to a document there will be 

obvious problems if you forget it!). 

The 'Author' and 'Comment' fields are for your use only 

and are not used by That's Write. 

That's Write automatically update the 'Creation' date 

and the most recent 'Change' fields. 
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You can specify a new 'Page Layout. .. ' for the current 

page(s) by clicking on the 'Page Layout' fi eld or entering 

[Control][P] and then selecting a particular layout from 

amongst those previously saved to disk: 

-G 
I Ss Single Sheet 11" 

2 Pl * 

<> 

HeH page layout: Pll OK I Cancel I 

Clicking on the paragraph layout identifier or entering 

[Control][A] displays the following dialogue box from 

which you can select a new 'Paragraph Layout...'. 

9 
: BT Body Text * 2 SH Sub Head 

:1 HL Headline 
'4 Al 

6 

M eH parag layout: BTI OK I Cancel I 

149 



User Manual That's Write 

If you have marked a block of text the new 'Paragraph 

Layout' will be assigned to all paragraphs in the marked 

block and the text will be reformatted accordingly. 

You can jump between pages by clicking on the page 

number or by pressing [Control][G][P]. 

Page: ~--
OK 

I Cantel I 

Similarly, by clicking on the line number or by entering 

[ControlJ[G][L] you can jump to a given line. Line 

numbers start from one on each page so with this 

command you can only move within the current page. 

Line: ~---
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By clicking on the column number or by entering 

[Control][G][C], you can move from column to column. 

Collll'ln: ~--
OK 

I Cantel I 

* With proportional text you should remember that 

characters differ in width and therefore two 

characters that arc directly above one another in the 

text do not necessarily have the same column 

number. 

By clicking on the arrows at the end of the Info line, you 

can scroll the text on the screen. Alternatively, use the 

[Shiftl and cursor keys. 
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7.2 Additional keyboard commands 

Not all the That's Write commands are available from the 

menus. The additional keyboard commands are mainly 

used to process a single word or line. 

The cursor keys move the cursor one character to the left, 

right, up or down. If you press [Shift] and a cursor key at 

the same time the cursor will move a word left or right, or 

a screen up or down. Press [Control] and [t] to move to 

the beginning of the text, [Control] plus [ .&. ] to jump to 

the end of the text. 

[Delete] has a double function . If [Delete] is pressed 

alone only the character to the right of the cursor will be 

deleted. If you press [Shift][Delete] a complete word is 

deleted and [Control][Delete] will delete a complete line. 

The [Space bar] puts a space between words or characters 

in the same way that a typewriter would. During the 

formatting of text, That's Write uses these spaces to 

choose where to place line breaks and to perfonn 

justification. 
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Therefore a name like ATARI ST could be pulled and 

stretched apart or divided over two lines. To prevent this 

you can use the "hard space"; That ' s Write treats a "hard 

space" as an ordinary character. Press [Control] and the 

space bar simultaneously to activate a "hard space". 

A maximum of ten positions can be marked in the text at 

one time and you can move the cursor to them quickly 

using keyboard commands. To mark a position place the 

cursor on it and press [Control][M][l], [Control][M][2], 

[Control][M][3] up to and including [Control][M][O]. 

Using [Control][G][l], [Control][G][2], [Control][G][3] up 

to and including [Control][G][O], you can jump to the 

relevant marked position . If you delete the text around a 

marked position, any marking is also deleted. When 

saving text markings will also be saved and will remain 

in place when the text is re-loaded. 

Other commands: 

[Con trol][D ][T] 

[Control] [D] [D] 

Inserts the current 

time at the cursor 

position. 

Inserts the current 

date at the cursor 

position. 
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[Control][D][M] Inserts the current 

date at the cursor 

position; the month is 

written out as a name 

instead of a number. 

[Control][ShiftHt] Moves from the main 

text to header or from 

footer to main text. 

[Control][Shi ftH!.] Moves from the main 

text to footer or from 

header to main text. 

[Control][G][F] Move cursor to 

beginning of the next 

page. 

[Control][GJ[B] Move cursor to 

beginning of the 

previous page. 

r control] [I] [I] Shows the info box 

which contains a 

copyright notice, the 

amount of free memory 

and the number of 

words in the document . 

[Control] [l]l 1 ], [2], [3] Calls the accessory 

with the given number 

(works only up to 
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accessories following 

the Xac protocol. 

Details of the Xac 

protocol are available 

on request). 

[Control][Xl Transposes the two 

letters immediately 

before the cursor eg it 

becomes it. 

[Shift][-+] Word right 

[Shift][+-] Word left 

[Control][-+] Go to end of line 

[Control][+-] Go to beginning of 

line 

[Controlllt] Beginning of 

document 

[Con trotH .1.1 End of document 

[Shift][ .1.1 Screen down 

[ShiftH .1. J Screen up 
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8. Macros 

That's Write has another important advantage over most 

other ST word processors - macros. 

A macro is a collection of keyboard and menu commands 

which can be executed by just two keystrokes. Macros 

can be used for storing common phrases such as "Yours 

sincerely", or to automate That's Write keyboard 

sequences such as those necessary to set a particular 

paragraph style. 

Every key on the keyboard with the exception of [Shiftl, 

[Controll and [Alternate] can be defined as a macro key. 

Macro definitions can be loaded and saved with the 'Load 

Macro' and 'Save Macro ' commands in the 'Options' 

menu. If you create a number of macros and save them 

under the file named 'TWRITE.MAC' in the 'TWRITE' 

folder, they will be loaded automatically each time 

That's Write is started. 

To begin a macro definition press [Shift][Esc] then 

release them and press the particular key you wish to be 

defined. All keyboard and menu commands issued 

following the nomination of the macro key will be 
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recorded in the macro including any errors and 

corrections, as well as being executed immediately. This 

can also include commands in dialogue boxes using 

keyboard short cuts. Selections of fields or buttons with 

the mouse are not stored. When you have finished 

defining your macro press [Shift][Esc] again. 

While defining a macro, each character or command that 

is entered produces a sound to remind you that a macro is 

being recorded If your monitor supports sound, it is best 

to turn it up when defining macros. 

It is possible for one macro to call another macro; macro 

calls can be nested up to ten levels. Once a macro has 

been defined it can be . activated by pressing and 

releasing [Esc], followed by the defined key. This results 

in the same sequence of key entries being executed 

again . Do not press [Esc] and the defined key at the same 

time. 

The execution of a macro can be stopped at any time by 

holding down both [Shift] keys for a short time. 
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The macros entered on the function keys Fl to FlO are 

treated in a special way. To execute them once they have 

been defined you do not need to press [Esc], the function 

key alone is sufficient. 

For advanced users of That's Write, there is the option of 

creating a macro loop. This is done by letting a macro 

call itself. When such a macro is executed, this recursive 

call is interpreted as a jump to the beginning of the 

definition. Any commands that might follow this jump 

are never executed. 

Non-terminating macros would be a waste of time!. 

Therefore these loops are terminated whenever the cursor 

reaches the start or end of the document either by cursor 

movement or as a consequence of an unsuccessful search 

operation. This makes it possible to program a macro that 

will search for all occurrences of a certain word and 

change its style to Italic. Other advanced applications are 

only limited by the imagination of the user. 
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9. Printer configuration 

That's Write comes with a selection of printer 

configurations for almost all printers in common use. If 

the list of printers displayed by That's Write during 

'Installation' does not contain your printer, check to see 

if your printer is compatible with one of those listed. 

If none of the supplied configurations work with your 

printer, call the Helpline. There may already be a printer 

driver available for your printer. If not, technical 

information is available that should help you to create 

your own driver. 
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10. That's Snap 

That's Snap makes it possible for you to take a 

"snapshot" of the screen, or selected parts of it and save 

it in GEM Image format. Once That's Snap has been 

selected an Alert box is displayed where you select 'OK'. 

Then you need to mark the area of the screen that you 

want to save with a "lasso". 

To do this move the mouse cross-hairs to the top left hand 

corner of the part of the screen that you want to save, 

click on and hold down the left mouse button. Move the 

cross-hairs to the bottom right of the screen area and 

release the left mouse button. As you release the mouse 

button you will see your selected screen area "lassoed" in 

a dotted square or rectangle. When you have taken your 

"snapshot" That's Write displays a file selector box in 

which you should enter a name for your image. 

Remember, the file name should have the .IMG suffix. 
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Unfortunately, many programs do not allow the use of 

accessories. If you wish to take a snapshot while running 

such a program press [Alternate], [Right Shift] and [Help] 

and the screen will be saved in a special buffer. On some 

STs, registering a few key repeats occasionally freezes 

the screen for a short time. 

After quitting the program or after loading That's Write 

you can select the That's Snap accessory from the menu 

bar. A 'Which screen' alert box will appear offering a 

choice of three buttons 'Cancel', 'Current' or 'Buffer' . If 

you select 'Current' you enter the normal That's Snap 

function, if you select 'Buffer' you will be presented 

with the screen that was displayed at the time you 

operated the [Alternate][Right Shift] [Help] function. 

Using the mouse cross-hairs you can make an image of 

the screen or part screen as you prefer. 

The [Alternate][Help] option is used to make a hard copy 

of the screen on a printer. 
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11. Keyshow 

Keyshow is a desktop accessory shipped with That's Write 

which enables you to display on screen the way 

characters are assigned to different keys on the keyboard. 

When you click on Keyshow from the desk accessories 

menu, the mapping of the currently active font is 

displayed. Use [Shift], [Alternate] and [Shift][Alternate] 

together to display all the characters in the font. 

You can use the mouse pointer to point to the particular 

character you want to insert into your text then click on 

the left mouse button - the character wi ll automatically 

be placed at the current cursor position . 

* Try using Kcyshow with BOX&LINE the currently 

active font. 
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12. That's Select 

That's Select is an alternative File Selector supplied on 

the That's Write Master Disks in a file FSEL.ACC. This 

accessory is not necessary for running That's Write. 

However, you can use it with other GEM programs on the 

ST to replace the standard ST File Selector with That's 

Select. Thus with other programs, all File Selector 

operations can be keyboard controlled. 
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13. Dictionary maintenance 

The That's Write Help program may include some 

dictionary maintenance functions. These are not used by 

versions 1.51 or later but may be necessary to access 

dictionary files created with earlier versions of That's 

Write. 
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14. That's Font 

That's Write uses GEM fonts for its screen display and 

graphics print out. If you possess GEM screen fonts from 

other programs you only need to make printer fonts to use 

them in conjunction with That's Write. 

That's Font allows you to make screen fonts and fonts 

which can either be printed in graphics mode or down 

loaded to some printers. That's Font contains more 

functions and parameters than you will ever need to use 

with That's Write . 

After starting 'TFONT.PRG' the following fields will 

appear. 

Desk file Edit Options fornat 

6et character : ,;,;t1n11r.;'llln1!tn-lnonafl'l c 888. 

B 9 
0 

Dlii I -I 888 I+ I 

*·0 4ih11M I Merge I 0 

Store tharac ter: 
B 

Dlii I - I 888 I+ I 0 

@ 
0 

Hove 
cheretter: I <- 0 I 

BB EE ~+D [i]+~ 

~+[ljj D+D D+D 
~ 

<> 0 
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In the large window to the right you will see a matrix. 

You can use this matrix to design your font characters. To 

set a point click on the left mouse button, to delete a 

point click on the right mouse button. 

First select 'Load font 1' from the drop down file menu 

and load a font of your own choice from That's Write to 

practice on. It is easier to modify an existing font than to 

create a new one from scratch. 

6et LharaLter: 

IDI~ I - I ooo 
B 

I + I 
Merge 

The 'Get character' command in the top left window 

allows you to select the character you wish to process or 

modify. 

There are two options available to you. You can click on 

the small symbol in the top right hand side of the window 

(the symbol turns black when selected) then press a 

character key. The ASCII value of the character will be 

placed in the field between the (+) and (-) signs. 

Alternatively, you can choose the required character by 

clicking on the + and- pads with the mouse buttons. 
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* If you decide to use the + and - pads to choose your 

character you must first deactivate the key symbol in 

the top right corner by entering a character from the 

keyboard. 

Store tharatter: 

DCD I - I ooo I + I 

The ASCII value (decimal) and its relevant character will 

appear between the + and - pads. To place the character 

in the matrix click on the ASCII value shown. 

If you place a new character in the matrix 'Overwritc' 

clears the matrix of any old characters. 'Merge' leaves 

the old characters in the matrix and places the new 

character over the old character. 

The box beneath 'Store character' places the new 

character in the font. It works in the same way as the top 

box. 'Store character' is only used if the automatic save 

function is not activated. 

Move ~ 
character: ~ 
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'Move character' moves the character within the matrix 

via the use of the four arrow pads. 

The remaining box contains six functions which can be 

activated by clicking on the appropriate symbol. 

a) The symbol with the left and right arrows (top left 

symbol) mirrors the character in the horizontal plane 

of the matrix. 

b) The symbol (second top left) with the up and down 

arrows mirrors the character in the vertical plane of 

the matrix. 

c) The third top row symbol, with a full and empty pad, 

deletes a character. You will be asked to confirm 

your request before this command is carried out. 

d) The last symbol uses the 'skewing mask' of the 'Font 

Info• dialogue box to change a character into an 

italic character by slanting it. 
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e) The symbol with the black and white pads at the 

bottom left inverts a character in the matrix by 

turning white dots black and black dots white. 

f) The symbol at the bottom right, with the large and 

small pads, changes the display size of the matrix 

dots. 

That's Font offers two additional functions: 

Pressing [F9] moves the complete font one dot down in 

the matrix, pressing [F 10] moves the font one dot up. 

Pressing [Fl] selects a line function. You can select the 

starting point of a line by pressing [Fl] and then clicking 

on the first dot in the matrix. If you click on a second dot, 

a line will be drawn between these two dots. 

Further commands are available via the menus in the 

menu list. 
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14.1 The File menu 

14.1.1 Load font 1 

Save font 1 
Save font Z 

Load keyboard 1 

Save keyboard 

Du it 

That's Write 

This command allows you to read fonts from the disk. 

14.1.2 Load font 2 

This command allows you to load a font without the 

header containing the GEM information making it 

possible for single characters to be copied from one font 

to another. 

* To load a font into •Font set 2• you must activate the 

•load data only• option if you don•t the information 

in •Font set 1• will be lost. It is not possible to work 

on two fonts separately at the same time. 
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14.1.3 Save font 1 

14.1.4 Save font 2 

Your font is now saved to disk. 

14.1.5 Load keyboard 

Up to now, you have only changed the design of the 

characters. You must tell That's Write which key the new 

character is to be assigned to. You use key tables to do 

this. You can load a keyboard by using this command. 

You only need to define a key table if the 

STANDARD.KEY table of That's Write does not suit your 

needs (eg BOX&LINE alters the decimal key pad). A 

special key table must have the same name as its font (eg 

SBOXLINE.FNT - SBOXLINE.KEY). 

14.1.6 Save keyboard 

This command saves an amended or newly made key table 

to disk. 

14.1.7 Quit 

'Quit' returns you to the GEM desktop. 
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14.2 The Edit menu 

14.2.1 Show Font 

Display fornat ... 
Font info.,, 

That's Write 

If you select this command a window will appear at the 

bottom left of the screen displaying all the characters of 

Font 1 or Font 2, depending on the selection in 'Display 

format'. 

H I J K L M 
0 P Q R S T 
V wx y z I 
I a b 

This window has all the attributes of a GEM window. It 

also has two special functions: 
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a) If you double click on a character it will appear in 

the matrix. 

b) If you click on a character once, it becomes inverse. 

Now press the key on the keyboard that you wish to 

be defined with the selected character. The relevant 

key table will be adjusted. 

14.2.2 Standard keyboard 

After modifying the keyboard table the original QWERTY 

keyboard can be restored by selecting 'Standard 

keyboard'. 

14.2.3 Compress font 

Using a proportional font means that the characters have 

differing widths. During the design, you do however use a 

matrix that is the same width for all characters. The 

command 'Compress font' removes all undefined 

characters from the font. 

* Please ensure that when you design a proportional 

font, you only select this command at the very end. 
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14.2.4 Display fonnat 

Display forMat: 

X-Fattor: 0011 

X- Dlstance: OD 

Font: DDJ 

Y-Fattor: 001 

Y-Distante: DO 

OK 

I Cancel I 

That's Write 

As this command suggests, it only influences the current 

display font window. Depending on the preferences you 

enter here the horizontal and vertical size of the 

character will be modified or the distance between the 

characters in the horizontal and vertical plane will 

change. 

The definitions have no influence on the font and do not 

work in the matrix. 
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14.2.5 Font info 

Font info 

Ha"e: HelBo 14~----------------------
Hu"ber: 882 Font size: 814 Proportional 

first tharatter: 804 
Height: 827 
Left offset: 804 
Bold lines: 882 
Lightening "ask: 
Ske~o~ing "ask: 

Last tharatter: 258 
Hax. 1d dth: 030 
Right offset: 010 
Underline position: 003 

0110•o.o~~ 
DIID.D.oll 

Base line: 885 Half line: 815 
Botto" line: BOB Astent llne: 01' 

lr--:DK,....---.11 Cantel I 

As mentioned at the beginning of this Chapter, That's 

Font has not been specifically designed for That's Write . 

Therefore some details in the 'Font info ... ' dialogue box 

have no relevance to That's Write. The important 

parameters are as follows: 

Name: 

Proportional: 

First character: 

Here you enter the name of the 

font, as it appears in the 'Font' 

menu of That's Write. 

Should be inverted. 

Normally 4. 
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Last character: 

Height: 

Width: 

Bold lines: 

Underline pos: 

Skewing mask: 

176 

That's Write 

Up to 255 

Here you enter the maximum 

height of your font in points. This 

should include the space above 

the highest character. 

Here you enter the maximum 

width of your font in points. The 

width should be a minimum of 3 

times the width of the widest 

numerical character. 

How many dots a graphic font will 

be emboldened by. 

How thick the underline/double 

underline will be 

This function only applies to 

TFONT•s italic function. 
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Base line: 

Ascent lines: 

User Manual 

This value decides the ground line 

to which all characters will be 

adjusted when using different 

fonts. The value is given in 

points. 

Used for the strike through text 

style. The lines are usually the 

height of the Capital E. 

All other values given are of no importance to the GEM 

fonts that That's Write uses but arc not necessary when 

using That's Write and they are not recognised by the 

screen or printer. 

* If you change the values of the maximum width or 

height the processed fonts will be deleted. 

14.2.6 Change keyboard table 

Using That's Font you can change the definitions of the 

keys (eg when working with foreign languages). This is 

very useful when you want to use specially accented 

characters. 

To do this follow these instructions: 
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a) Load font l (eg SPICA) 

b) Show font l 

c) Click once on the character in the 'Show Font' 

window that you wish to include in the 'Key table' 

d) Press the key you wish the character to be assigned 

to. 

e) Save keyboard. 

* A key table has to be assigned to a font by using its 

name. When That's Write switches to this font the 

corresponding key table is used. If there is no font 

specific key table the 'ST ANDARD.KEY' table is 

used. 

If you load keyboard table 'STANDARD.KEY' from the 

'TWRITE' folder, modify it and save it, it will affect all 

the font s that do not have their own key table. Therefore, 

it is important that you make a backup of your 

'STANDARD.KEY' file . 
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14.3 The Options menu 

Both options work as switches. A tick to the left of an 

option indicates that it is activated. 

14.3.1 Automatic storing 

As long as this option is activated all changes in the 

matrix of the font will be automatically saved in RAM. 

The manual 'Store character' can then be ignored. 

14.3.2 Load data only 

Since you cannot normally change the details in a 

processed font, this function has been adopted. Using this 

you load only the character information not the 'header' 

of a GEM font containing the information about the 

sizes. Should you wish to change the sizes in 'Font Info' 

then load the characters of the font. If the font you load 

is smaller than the information in the 'Font Info' an alert 

box will ask if you want to scale up the characters. 

179 



User Manual That's Write 

This function makes it easy to generate a graphic printer 

font from a screen font. You don't have to generate the 

complete printer font, you only have to optimize the 

single characters. 
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Finally, That's Write has one more requirement for all 

character sets. The characters with an ASCII value from 4 

to 31 must be used in the following way: 

ASCII 

4 
5 
6 
7 
8 
9 
10 
11 
12 
13 
14 
15 
16 
17 
18 
19 
20 
21 
22 
23 
24 
25 
27 
28 

29 

30 

31 

Character 

[ 
0 
1 
2 
3 
4 
5 
6 
7 
8 
9 
] 
0 
1 
2 
3 
4 
5 
6 
7 
8 
9 

## 

K 

k 

Purpose 

Start of an Endnote 
Endnote character 0 
Endnote character 1 
Endnote character 2 
Endnote character 3 
Endnote character 4 
Endnote character 5 
Endnote character 6 
Endnote character 7 
Endnote character 8 
Endnote character 9 
End of Endnote 
Footnote 0 
Footnote 1 
Footnote 2 
Footnote 3 
Footnote 4 
Footnote 5 
Footnote 6 
Footnote 7 
Footnote 8 
Footnote 9 
used for hyphenation 
Page number symbol (only in 
screen fonts) 
Capital K (used for German 
language hyphenation) 
lower case k (used for German 
language hyphenation) 
used for hyphenation 
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Appendix 1 
A 1 Wordstar Command Set 

The File menu 
Open Text... 
Insert Text. .. 
Save 
Save as ... 
Delete File ... 
Print... 
Quit 

The Block menu 
Start 
End 
Copy 
Move 
Delete 
Save 
Hide 
To Start 
To End 

The Style menu 
Normal 
Bold 
Underlined 
Double Underlined 
Strike Through 
Italic 
Superscript 
Subscript 

The Layout menu 
Format Paragraph 

The Edit menu 
Search ... 
Repeat Search 
Replace ... 
Foot-
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[Control][K]LAJ 
[Control][K]lA] 
[Control][K][Xl 
[Control][K][S] 
[Control][K][J] 
[Control][K][P] 
[ControlHKHQI 

[Control][K][B] 
[Control][K][K] 
[Controi][K][C] 
[Con trol][K][V] 
[ControlHK][Y] 
[Control][K][W] 
[Contrail [K 1 [H] 
[ControlHQHBl 
[ControlHQHKl 

[ControlHPHNl 
[Controll[P][B] 
[Control][Pl[Sl 
[Control][P][D] 
[Control]lPl[X] 
[Control][P][Y] 
[Controi][Pl[TJ 
[Control][Pl[Vl 

[Controi][B] 

[Control][Q][F] 
[Control][L] 
[Control][Q][A] 
lControlHFJ 

That's Write 
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Endnote 
Main Text 
Indent 
Page Number ... 

The Options menu 
Overwrite Mode 

[Control] [E] 
[Control][M] 
Unsert] 
[Control]LS] 

[ControlHVJ 

Appendix 
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Index 

1st Word 36, 63 

1st Word Plus 36, 63 

Accented characters 177 

Active font 92 

Alert Boxes 9 

Align text 73 

All 119 

Alternatives 131 

.ARC 19 

ASCII 36, 63, 181 

At ari SLM 804 72 

Auto 28 

AUTOINF 28 

Automatic Formatting 133 

Automatic Pagination 133 

Automatic storing 179 

Back 117 

Backspace 9 

Backup 7, 11 

Backup disks 16 
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Block buffers 86 

Block menu 83 

BOX&LINE 162, 171 

Buffer 86 

Buttons 9 

Caps lock indicator 145 

Carriage return 110 

Centred tab 59 

Change keyboard table 177 

Change windows 44 

Changing Fonts 91 

Character string 117 

Check Spelling 129 

Column number 151 

Columns 108 

Complete words 117 

Compress font 173 

Control commands 38 

Copv 88 

Copy File ... 68 

Create more free memory 95 

Cursor 8 
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Cursor keys 4, 8, 152 

Cut... 86 

Date 153 

Decimal character 141 

Decimal tab 59 

Default font 53 

Default layout 103, 114 

Default printer 32 

Delete 9,89 

Delete File ... 68 

Delete IMG 129 

DEMOl.TW 27 

DEM02.TW 27 

Desk accessories 162 

Desktop accessories 74 

Desktop accessory 162 

Dialogue box 45, 61 

Dialogue Boxes 9 

Dictionary 130, 135, 142 

Dictionary disks 132 

Dictionary files 164 

Dictionary maintenance 164 

186 



That's Write Index 

Document name 145 

End 84 

End Checking 132 

Endnote 120 

Fast draft print 114 

Field 75 

File selector 40, 163 

Find paragraph endings? 64 

First line left margin 58 

Font 91 

Fonts 93, 165 

Foot margin 48 

Foot er 108, 154 

Footer text 48 

Footnote 120 

Footnote distance 109 

Footnote number offset 147 

Format Document 110 

Format Paragraph 110 

Formatting text 46, 101 

Forward 117 

From Clipboard 88 
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From Layout 98 

FSEL.ACC 27, 95, 163 

Function keys 158 

Galleys 108 

GEM 9 

GEM fonts 165 

Graphic printer font 180 

Graphics mode 165 

Hard page break 52, 124 

Hard space 153 

Header 108 

Header text 47 

Heading level indicator 145 

Heading levels 123 

Helpline 6 

Hide 90 

Hide Paragraphs 112 

Hyphenation ... 136 

Ignore 117 

.IMG 160 

.IMG format 126 
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Immediate Checking 135 

Indent 121 

Index 125 

Info line 43, 145 

Insert 65 

Installation 7, 21 

Installation ... 23 

Jusification 53 

Keyboard commands 38, 152 

Keys how 162 

KEYSHOW.ACC 27, 95 

Language 130, 142 

Language hyphenation 142 

LASER.ARC 19 

Last Version 66 

Left aligned tab 59 

Left indent 57 

Left margin 58 

Left-Foot 108 

Left-Head 108 

Line break 8 
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Line spacing 53, 104 

Load additional fonts 92 

Load data only 179 

Load files 63 

Load font 1 170 

Load font 2 170 

Load font... 92 

Load IMG ... 126 

Load keyboard 171 

Load Layout... 113 

Load Macro 156 

Load Macro ... 143 

.MAC 143 

Macro definition 156 

Macro loop 158 

Macros 156 

Mail Merge ... 74 

Main text 108, 121' 154 

Margins 47,53 

Mark Contents 100, 123 

Mark Index 99 

Master Disks 11, 16 
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Match 117 

Matrix 166 

Memory (RAM) 95 

Menu bar 9, 45, 61 

Merge 167 

Mode indicator 145 

Mouse 38 

Move 89 

Move character 168 

Multiple columns 108 

N24.ARC 19 

N9.ARC 19 

New 62 

New document 62 

Once 119 

Open ... 63 

Options menu 179 

Output port 71 

Overwritc 167 

Overwrite Mode 134 

Page break column 51 
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Page Layout ... 47, 145 

Page number 122, 124 

Page number offset 125, 147 

Page numbers 71 

Pagination 51, 111 

Paper 72 

Paragraph layout 53, 145 

Paragraph Layout... 55, 101 

Paste 87 

Picas 107 

Picture 126 

Preferences ... 140 

Print... 70 

Printer (BIOS) 71 

Printer (direct) 71 

Printer configuration 69, 159 

Printer drivers 24,29 

Printer fonts 73 

Printer installation 31 

Printer Type ... 69 

Proportional text 151 

Ouery 119 
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Quit 171 

QWERTY keyboard 173 

READ ME 5 

Record 75 

Remove Font... 74,95 

Rename File ... 68 

Repeat Search 118 

Replace 118 

Resolution 127 

Right aligned tab 59 

Right margins 57 

Ruler 104 

Ruler line 57 

Save 89 

Save as ... 34,66 

Save ASCII ... 67 

Save font 1 171 

Save font 2 171 

Save keyboard 171 

Save Layout 113 

Save Macro ... 144 

SBOXLINE.FNT - SBOXLINE.KEY 171 
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Screen display 73 

Screen fonts 165 

Scroll 151 

SDP 74 

Search ... 116 

Separation line 109 

Separation line distance 109 

Show Font 172 

Show Fonts 96 

Show IMGs 134 

Show Paragraph 112 

Single sided disk drive 12, 19 

Single sided version 19 

Skewing mask 168 

Snapshot 160 

Soft page breaks 51 

Space bar 152 

Spell check 135 

Standard keyboard 173 

ST ANDARD.KEY 171 , 178 

Start 84 

Stop hyphenation 138 

Store character 167 
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Style 97 

Style options 99 

Supplementary dictionary 131 

Tab 60 

Tab positions 53 

Table of Contents 100, 123 

Tabs 55 

Text Fields 9 

Text markings 153 

Text window 33 

Text windows 43 

TFONT.PRG 165 

That's Font 165 

That's Select 163 

That's Snap 160 

The Type menu 91 

THELP.PRG 11 

Time 153 

To Clipboard 88 

To End 90 

To Start 90 

TOP margin 47 

TSNAP.ACC 27,95 
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TWRITE.INF 142 

TWRITE.LAY 114 

TWRITE.MAC 156 

TWRITE.PRG 33 

TWRITE.TWP 32, 69 

Units 107 

White space 74, 137 

Wild Card 117 

Word processor 8 

Wordstar 141 

Wordstar Command Set 182 

Work Disk 21 

Write protect 17 

WRITE_ON.INF 31 
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